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物理評価のメリットと必要性 

純真学園大学 保健医療学部 放射線技術科学科 村上 誠一 

1. はじめに

現在、単純 X 線撮影領域において computed radiography（CR）や flat panel detector（FPD）などのディジタル

撮影システムが広く臨床で使用されている 1-3）。これらのディジタル撮影システムは、様々な画像処理を行うことで

高画質の画像を得ることが可能となってきた。その一方で、ディジタル撮影システムは写真濃度の自動補正機能

により適正な写真濃度の画像が得られるため、増感紙/フィルムシステムのように写真濃度から撮影線量の過不

足を把握することができない。よって、ディジタル X 線撮影システムでは画像ノイズを指標として撮影線量の過不

足を判断することになるが、増感紙/フィルムシステムの写真濃度のように容易に判断することが困難である。この

ことから、ディジタル撮影システムでは線量不足によって生じるノイズの増加を避けるため、撮影者は高い撮影線

量を選択する傾向にあることが報告されている 4-6)。岸本らや DRLs2015、2020 の国内における被ばく線量の実態

調査では、CR システムが普及し始めた 1993 年以降 FPD システムのような高感度検出器が開発されたにも関わ

らず、撮影部位によっては入射表面線量が同一もしくは増加した部位もあり、撮影頻度の高い胸部撮影では

1993 年時と比べ 2020 年で約 2 倍の入射表面線量であることが報告されている 1,7,8)。この理由として過去に使用

されていた増感紙/フィルムシステムにおける撮影条件をそのままの基準としてディジタル撮影システムで用いて

いる施設が多いことが主要因として挙げられている。診療放射線技師や研究者にとって、被ばく線量を可能な限

り低く抑えると同時に出来るだけ高い画質（診断能）の画像を作製することは責務であり、これまでに多くの研究者

により被ばく線量と画質に関する研究が行われてきた。画質の評価には検出器の特性を示す物理的画質と臨床

的な特性を示す臨床的画質の評価が必要となるが、臨床的画質の決定には対象とする疾患や目的に加え施設

による考え方が異なるため、一意的に定義することは困難である。よって、一般的に放射線画像の画質評価には、

入出力特性、解像特性、ノイズ特性、NEQ（Noise Equivalent Quanta）および DQE（Detective Quantum Efficiency）

といった物理評価が用いられている。これらの画質に関する物理評価は、IEC（International Electrotechnical 

Commission）により確立された測定方法が定義され、再現性および精度の高い測定・解析が可能で被ばく線量と

関連付けることで放射線画像の最適化の有効な資料を得ることができる。また、これらの物理特性は画質評価以

外に得られた定量値を経時的に測定することにより撮影装置の品質管理を行え、異常の早期発見および原因究

明に非常に有効であり、撮影装置を常に最良のコンディションに保ち患者様に検査を提供できるメリットがある。 

本稿では、臨床現場における撮影条件の初期設定および装置の品質管理における物理評価の活用例を示し、

物理評価のメリットと必要性について述べる。 

2．物理的な画質評価に基づく撮影条件の初期値設定 

一般的に装置導入に際し重要な事は、導入した撮影システムが従来のシステムと比較して検出器の性 

教育講演
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能が優れているのか、または劣って

いるのか、得られる画質はどうなの

か、更には被ばく線量が低減できる

かを明確にし、撮影条件を決定する

ことである。ここでは、Table に示す

CR システムから FPD システムへ更

新した際の撮影条件の設定におけ

る物理評価の活用例について述べ

る。なお、本稿で提示する入出力特

性、解像特性、ノイズ特性および DQE は、IEC62220-19)に準拠し、RQA５の線質を利用して生データから得られ

た測定結果を示している。 

 

2.1 入出力特性（ディジタル特性曲線） 

ディジタル撮影システムの入出力特性は、相対 X 線強

度と検出器から得られた画素値の関係を求めたもので、

検出器の入射線量と画素値の直線性、システムのコントラ

ストやダイナミックレンジなど検出器の基本的な情報が得

られる。Fig.1 に横軸に検出器入射線量の対数値、縦軸に

画素値をとった CR システムと FPD システムのディジタル

特性曲線を示す。同図より両システムとも約 104程度の線

量域を表現可能であり、広いダイナミックレンジを有してい

ることが分かる。しかし、表現可能な線量域はシステムで

異なり FPD システムは CR システムに比べ低い線量域を

画像化することが可能であるが、画素値が低い線量で飽

和するため、高い線量での撮影はできないことがわかる。

Fig.2 に過線量に起因する黒潰れが生じた一例を示す。

図より、FPD システムでは検出器入射線量が 90μGy で肺

野の広範囲に黒潰れを生じているが、CR システムでは検

出器入射線量が 180μGy でも黒潰れは生じていないこと

がわかる。日常臨床において、180μGy の高線量が検出

器へ入射することは考えにくいが、90μGy はフォトタイマの切り替えミスにより設定したバックアップの照射時間で

X 線が出力された際や小児撮影、さらには X 線吸収差の大きな胸腰椎移行部側面撮影や股関節軸位撮影など

では現実的に起こりえる線量であり、FPD システムは臨床で使用できる有効な撮影線量域が CR システムより狭い

と言える。また、Fig.3 のように肺気腫や気胸など局所的に X 線の透過の高い領域では検出器の入射線量が局所

的に高くなり黒潰れを生じる可能性がある。FPD システムを導入当初、この黒潰れを病変と診断され追加検査とし

て CT 検査が実施された事例を数例経験した。このような事態は、誤診の原因や不必要な検査の実施となるため、 

Table 本稿で比較する２つの DR システムの仕様 

 

 
Fig.1 ２つのシステムのディジタル特性曲線 

  
(a) (b) 

Fig.2 異なる検出器入射線量で撮影した胸部ファントム像 

(a) FPD システム：90μGy  (b) CR システム：180μGy 
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装置導入時には検出器の入出力特性を測定し、利

用可能な線領域を把握することが重要である。 

 

2.2 解像特性 

 解像特性は、システムがどこまで小さな物体を解像

できるか非常に重要な特性を示す指標である。ディ

ジタル撮影システムでは、一般的に各空間周波数に

対応する応答特性を表すプリサンプルドMTFを解像

特性の指標としている。Fig.4 に FPD システムと CR

システムのプリサンプルド MTF を示す。FPD システ

ムのプリサンプルド MTF は、全周波数において CR

システムより高い値を示し、FPDシステムが高解像度

のシステムであることを示している。MTF は、ノイズに

影響されない状態で高コントラスト物質の伝達特性

を示した指標であるため、ノイズの影響を強く受けた

場合 Fig.5 に示すように解像特性が悪く見える。した

がって、この様な状況下では解像特性の結果と視覚

的な画質評価は一致しない。しかし、Fig.6 のように

対象が高コントラスト物質（骨や石灰化）でノイズの

少ない状態であれば MTF の結果は視覚的な画質

評価とよく一致する。Fig.7 に CR の基準線量で撮影

した手関節のファントム像を示す。図より、解像特性の高い FPD システムは、CR システムに比べ骨梁構造が明瞭

に描出され MTF の結果とよく一致していることがわかる。 

 

2.3 ノイズ特性（粒状性） 

画像ノイズは、画像を観察した時に受けるざらつきで、臨床で利用される線量域では X 線量子ノイズの影響を強

く受ける。特に、病変などに多く見られる低コントラスト物質は、Fig.8 に示すように検出器入射線量が低下するとノ

イズ量が増加し、信号がノイズに埋もれることで識別が不可能となる。したがって、ノイズ特性は低コントラスト物質

の検出に大きく影響する因子となる。この物理的なノイズ特性を把握するためにディジタル撮影システムではディ

ジタル WS（Wiener spectrum）や NNPS（normalized noise power spectrum）が測定されている。この物理的なノイズ

特性は、視覚による評価とよく一致することが知られている 10,11)。Fig.9 に検出器入射線量 8.76μGy の NNPS を

示す。図より、FPD システムは CR システムより明らかに低い値を示し、粒状性が優れていることがわかる。Fig.10

に 1.0cycles/mm における NNPS 値と検出器入射線量の関係を示す。両システムとも検出器入射線量の増加とと

もに NNPS 値は低い値を示し、特に FPD システムは CR システムより同一検出器入射線量で低い NNPS 値を示

し、低コントラスト物質の検出に優れているといえる。また、同図より同一のノイズ量（NNPS 値＝1.0E-5mm2）を得る

ための FPD の検出器入射線量は CR システムの約 1/4 となり、低コントラスト物質の信号（病変）を検出目的とし

た場合の被ばく線量の低減の指標としても利用することができる。 

 

Fig.3 局所的な線量過多により生じた黒潰れ像 

 

Fig.4 2 つのシステムのプリサンプルド MTF 
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Fig.9 2 つのシステムの NNPS Fig.10 2 つのシステムの検出器入射線量と NNPS 値の関係 

 

 

2.4 検出量子効率 

検出量子効率（detective quantum efficiency: DQE）は、検出器が X 線光子をどの程度、有効利用して画像形

成に寄与したかを示したもので総合画像評価の指標として用いられている。Fig.11 に検出器入射線量が 

    

(a) (b) (a) (b) 

Fig.5 撮影線量を変えて FPD システムで撮影されたチャート像 

(a) 基準線量 (b) 基準線量の 1/10 

Fig.6 CR の基準線量で撮影した石灰化像 

(a) FPD システム (b) CR システム 

  
  

(a) (b) (a) (b) 

Fig.7 CR の基準線量で撮影した手関節像 

(a) FPD システム (b) CR システム 

Fig.8 撮影線量を変えて FPD システムで撮影された 

ビーズ像  (a) 基準線量 (b) 基準線量の 1/10 
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Fig.13 異なった線量を用いて FPD システムで撮影された手関節像 

8.76μGy の時の FPD システムと CR システムの DQE を示す。図より、FPD システムは CR システムより全周波数

において高い DQE 値を示し、1.0cycles/mm における FPD システムの DQE 値は CR システムに比べ約 4 倍の高

い値を示した。この結果は、検出器の画質特性の観点から CR システムと同等の画質を得る FPD システムの撮影

線量は、CR システムの撮影線量の約 1/4 で良いことを意味している。Fig.12 に CR の撮影線量を基準とし、その

1/2、1/4、1/8 の撮影線量で胸部ファントムを撮影した時の横隔膜下の模擬腫瘤像を示す。図より、CR システム

の基準線量の約 1/4 の線量で撮影しているにも関わらず FPD システムの方が CR の基準線量で撮影した CR シ

ステムより粒状性が優れていることがわかる。同様に Fig.13 に CR の撮影線量を基準として撮影線量を 1/2、1/4

と変えて FPD システムで撮影した人体ファントムの手関節像を示す。図より、基準線量に比べ 1/4 線量ではやや

ノイズが増加するものの基準線量の骨梁陰影の見え方と比べ殆ど差がないことが分かる。この DQE の結果から、

CR システムの基準線量の約 1/4 の撮影線量を FPD システムの初期条件に決定した。このように、検出器の物理

特性を測定することで大まかな画質を推測でき、撮影線量の初期値が決定可能となる。最終的な撮影線量の決

定は、撮影管電圧、グリッドの使用の有無、撮影部位や目的、画像処理を考慮し、臨床で使用しながら画像を視

覚的に確認したうえで微調整を行うことになるが、検出器の基本的な物理特性から撮影システムに応じた基準と

なる線量を概ね把握することができるのは大きな利点といえる。 

 

 

 

  

Fig.11 2 つのシステムの DQE Fig.12 異なった線量で撮影した模擬腫瘤像 
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2.5 検出器の管電圧依存性（線質依存性） 

 本稿で比較対象とした 2 つの撮影システムに使用されている蛍光体は、X 線エネルギーにより線減弱係数が異

なるうえ、臨床で使用する X 線エネルギー領域に k 吸収端を持つ。したがって、使用する管電圧（線質）により検

出器に吸収される光子の数が異なり蛍光量が増減し、入出力特性やノイズ特性が影響を受ける。以下に、本稿で

用いた検出器の管電圧依存性（線質依存性）について述べる。 

 

2.5.1 撮影管電圧と画素値の関係 

Fig.14 に同一の検出器入射線量で撮影管電圧を変えたときの画素値の変化を示す。図より、両システムにお

いて撮影管電圧が 80kV 付近までは管電圧が高くなるほど画素値は高い値を示し大きく変化するが、80kV 以上

120kV 以下ではほぼ同一の画素値を示した。一般的に蛍光体に吸収された X 線量と発光量は比例関係にあり、

検出器へ吸収される X 線量が多ければ蛍光量も多くなり結果として画素値は高い値を示す。仮に、検出器に管

電圧依存性がなければ管電圧と画素値の関係は一定となる。しかし、図から分かるように同一検出器入射線量で

あるにも関わらず、使用する管電圧が変化すれば得られる画素値も異なり、ここで使用した検出器は管電圧依存

性を有していることがわかる。つまり、この結果は使用する管電圧により入出力特性が変化することを示している。

最近のディジタル撮影システムでは不必要に多い線量や限度を超えた低い線量を回避するために EI（Exposure 

Index）が利用されている。この EI は管電圧 70kV を用いた RQA5 の線質のみでキャリブレーションされた入出力

特性を用いて検出器入射線量を推定する。したがって、前述したように検出器が管電圧依存性を持っていれば

推定誤差が大きくなることが容易に理解できる。このため EI を用いて線量の過不足を管理する際は、検出器の管

電圧依存性を調べ、管電圧や被写体厚によりどの程度の誤差を生じるか認識しておくことが重要といえる。 

 

2. 5. 2 撮影管電圧によるノイズ特性（粒状性）への影響 

Fig.15 に検出器入射線量を同一とした時の両システムの管電圧と RMS 粒状度の関係を示す。図より、両シス

テムともに管電圧により RMS 粒状度は異なり、FPD システムでは 80kV、CR システムでは 100kV で RMS 粒状度

は最も小さな値を示した。ここで求めた RMS 粒状度は、画素値の変動を算出した値のため階調数の異なる両シス

テムを比較することはできない。管電圧による RMS 粒状度の違いの要因は、両システムの検出器で用いられてい

る蛍光体の K 吸収端による影響と考えられる。FPD システムの蛍光体である CsI は、Cs の 36keV と I の 33 keV、

CR システムの蛍光体である Ba は 37keV に K 吸収端を持ち、この X 線エネルギーにおいて X 線吸収が大きくな

る。FPD システムで最も高い粒状を示した 80kV の実効エネルギーは 37keV、CR システムで最も高い粒状を示し

た 100kV の実効エネルギーは 39keV であり、検出器の蛍光体の K 吸収端を上手く利用することで粒状性が向上

することを意味している。この際、臨床画像で問題となるのは被写体コントラストの低下であるがディジタルシステ

ムでは画像処理により最終的な画像コントラストを調整できる利点があり、ディジタル特有の撮影条件が存在する

のかもしれない。これについては今後の課題といえる。 
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3. 品質管理 

 ディジタル撮影システムの品質管理は、米国医学物理学会（American Association of Physicists in Medicine：

AAPM）の Task Group 10（TG10）12)によるガイドラインが多くの国で模範として利用されている。品質管理の目的

は、システムの性能を常に維持し、画質や X 線の出力などに問題がないことを確認して、患者の診断や治療な

どを適切に行うことである。品質管理は、一般的に装置設置時の受け入れ試験や定期的な日常点検（不変性試

験）を行い、装置を管理することである。特に、装置設置時の受け入れ試験は、購入した装置が仕様書およびカ

タログデータ通りの性能を有しているかの確認や不変性試験の初期値を設定するうえで重要であり、客観的なデ

ータを示す物理評価を利用することで精度の高い管理を実施できる。一方、日常点検では簡易的なファントムを

撮影し目視評価による確認を行い、異常を発見した場合には物理評価を用いて初期値と比較し、原因追及を行

うことになる。しかし、多忙を極める日常業務の中で実施する日常点検は、得てして機械的な作業になりがちであ

るうえ、目視評価は評価者によりバラツキが大きく管理精度の低下が懸念される。本学会の平成 18 年度学術調

査研究班「CR システムの品質保証プログラムの構築および標準化検討班」では、Fig.16 に示す DR ファントムを

開発し、ディジタル撮影システムの品質管理のための自動化プログラムを構築することで前述した問題を解決して

いる 13)。物理評価を用いた定量的な管理は、品質管理の精度を高めることができ、撮影装置を常に最良のコンデ

ィションに保ち患者様に検査を提供すると同時に医療過誤などといった事態から組織を守ることが可能となる。以

下に受け入れ試験と日常点検の重要性を実感した一例を紹介する。 

 

  
Fig.14 同一検出器入射線量における管電圧と画素値の関係 Fig.15 同一検出器入射線量における管電圧と RMS 粒状度の関係 

  
(a) (b) 

Fig.16 品質管理用の DR ファントム (a) 外観図 (b) X 線画像 
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3.1 受け入れ試験の重要性の一例 

 20 数年前著者は、CT 装置購入に際し、装置性能を評価するために X 線出力特性、解像特性、ノイズ特性など

の物理評価を中心に受け入れ試験を実施し、解像特性の指標である MTF の値がカタログデータより逸脱したデ

ータを得た。日常診療では著しく影響を受けるような画質の低下は認められなかったが、当時このデータをメーカ

に提示したところ「測定精度が悪いのではないですか？」という回答がなされあまり相手にされなかった。日を変え

て繰り返し測定を実施したがやはり同様の結果であったため再度メーカにデータを提示したが適切な回答が得ら

れず、メーカの技術者とともに測定することを提案し、得られた結果もこれまでと同様であり原因追及が行われ、X

線管の焦点とその直下に設置されているコリメータのアライメントのズレが要因であることが判明した。これに伴い

幾度となくアライメント調整を行ったが上手くいかず一部の部品の入れ替えを経験した。最近の装置の多くがコン

ピュータ制御のためユーザが装置をテストし、性能を確認することが難しくなってきたが、装置管理は診療放射線

技師の責務であり、少なくとも診断に影響を及ぼす画質や線量の管理はユーザ自身が行い、購入した装置の性

能が仕様書やカタログデータから逸脱していないか、修理後の装置が元の状態に戻っているかは客観的なデー

タを取得し、確認を行うことが病院ひいては患者様に不利益を与えないことに繋がることを痛感した事例である。 

 

3.2 日常点検の重要性の一例 

 著者が以前勤務していた施設では、日々の始業点検において Fig.16 に示す DR ファントムを決められた撮影条

件下で撮影を行っていた。この点検により、X 線出力から画像表示まで一連の動作確認と自動化プログラムを使

用することで定量的に管理を行う。この管理において、フォトタイマの異常を検知した一例を紹介する。ある日の

日常点検において、フォトタイマを用いた DR ファントムの撮影で照射時間が通常時より長く許容値を超えた。要

因として考えられることは X 線出力またはフォトタイマの異常が疑われるため、まず X 線出力を測定し異常がない

ことからフォトタイマの異常が判明した。フォトタイマの故障は、患者被ばく線量や画質の担保に大きく影響するた

め重要な管理項目である。このケースのように管理ファントムを撮影するだけで早期に異常を発見でき日常点検

の重要性と必要性を実感した事例である。 

 

4. 終わりに 

本稿では、臨床現場における撮影条件の初期設定および装置の品質管理における検出器の画質に関する物

理評価の活用例を示し、物理評価のメリットと必要性について述べた。 

近年、医用画像の画質は飛躍的に進歩を遂げ、X 線撮影領域においても通常の画像診断を行うにあたり十分

な画質が得られるようになった。その一方で、私的な考えであるがディジタル撮影システムは増感紙/フィルムシス

テムのように線量に対する適正濃度という概念がないため、線量の過不足を判断することが難しくなり、必要以上

に高い画質を求めることで被ばく線量の増加という弊害を生じることを懸念している。放射線画像を取り扱う診療

放射線技師や研究者は、できる限り少ない線量で最大限の診断能を発揮する画像を医師に提供するように努力

する責務がある。検出器の基本的な物理評価は、検出器の何が優れ、何が劣っているか、定量値を用いて客観

的に評価でき、科学的な根拠に基づいた画質改善や被ばく線量低減の有効な資料として利用できることは最大

のメリットといえる。  

今後、少しでも多くの方が物理的な画像評価に興味を持ち、多くの研究を行いディジタル撮影システムに適し

た撮影条件の構築に期待する。 
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実践！！ DR システムにおける画像評価 

－画像取得から解釈まで－ 

「IEC62220-1-1 によるデータ取得方法と工夫」 

東北大学病院 診療技術部放射線部門 小野寺 崇 

 
1. はじめに 

ディジタル画像の物理評価は定量的であるがゆえに、画質の優劣を正確に評価することができ

る。ディジタルラジオグラフィ（DR）システムの画質的性能を表す検出量子効率（DQE）の取得を目

的に、IEC（国際電気標準会議）からその測定法が提案された。新システムを導入したとき、旧シス

テムとの DQE 比から線量低減率を推定できるなど撮影線量決定に大きく寄与する物理評価項目であ

る。しかし、解析用画像取得時の煩雑さや費やす時間がネックとなり、システム毎の DQE を取得し

ている施設は少ないと推察される。そこで本稿では、入出力特性・presampled MTF・NNPS について

IEC から提案された方法を解説し、加えてデータ取得時における注意点や工夫などを示す。 

 

 

２．IEC62220 シリーズと DQE について 

   IEC62220 シリーズは異なるメーカーの X 線検出器について、その性能を示す DQE を算出し比較す

る目的で発行された。その中で、IEC62220-1-1 は一般撮影系の静止画用検出器を対象として 2003

年に発行され、その後、2 回の改定を行っている。さらに 2007 年にはマンモグラフィ用検出器を対

象とした IEC62220-1-2、2008 年には動画用検出器を対象とした IEC62220-1-3 が発行されている。 

   上述したとおり、DQE は DR システムの画質的性能を表す指標であるが、その詳細は量子の検出効

率を表し、検出器が X 線量子をどの程度有効利用して画像の構成に寄与させているかを表すもので

ある。DQE は DR システムの入出力特性、modulation transfer function（MTF）、normalizes noise 

power spectrum（NNPS）を指定された線質で測定し、IEC62220 シリーズに示されている入射 X 線量

子数 q の値を用いて算出可能である。 

 

           𝐷𝐷𝐷𝐷𝐷𝐷(𝑢𝑢) =
𝑀𝑀𝑀𝑀𝑀𝑀(𝑢𝑢)

2

𝑞𝑞∙𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁(𝑢𝑢)
 

 

次章以降、入出力特性、MTF、NNPS それぞれの詳細について述べる。 

 

 

 

画像部会 
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３．入出力特性 

   本稿で示す入出力特性は IEC62220-1 シリーズにおいて、conversion function という名目で記さ

れている。これはディジタル値と単位面積あたりの入射光子数の関係を表している。しかし、本稿

では上式に従うこととし conversion function は使用せず、露光量とディジタル値の関係を測定

し、これを入出力特性とする。入出力特性の形式には大きく分けて２通りあり、ディジタル値が露

光量に比例する入出力特性をもつシステム（リニアシステム）と露光量の対数に比例するシステム

（log システム）が存在する。 

   次に、DR システムの入出力特性の測定方法について述べる。基本的にはアナログシステムと同様

の方法であるが、いくつか問題点がある。そのなかでタイムスケール法は撮影時間を変化させて露

光量を変化させる手法であり DR システムは相反則不軌が起こらないため問題なく、最も使用しや

すい手法である。データ収集の際には露光量をモニタリングするため線量計を用いる。Fig.1 に

IEC62220-1 が示す入出力特性の測定配置を示す。 

 

データ取得の際の X 線質であるが、DQE の算出までを目的とする

場合は IEC61267 および IEC62220 シリーズに規定されている線質

を使用する必要がある。これらの規定では一般撮影領域では RQA5

など 9 種類の線質が示されており、マンモグラフィ領域では RQA-

M2 などモリブデンターゲット・モリブデンフィルタを対象とする

4 種類とその他数種類の線質が推奨されている。これらの線質は

人体透過後の線質と同等となるような厚みのアルミニウム付加フ

ィルタを用いるため、アルミニウムから発生する散乱 X 線の影響

を極力少なくする必要がある。IEC シリーズで規定された線質を

用いることで照射線量から検出器に入射するフォトン数を求める

ことが可能となり、DQE を算出する際に非常に有効である。 

 

 

実際の測定ではモニタ線量を測りながらタイマを変化させて照射し、画像データを取得する。後述

する presampled MTF や NNPS の測定の際、低露光の入出力特性データが必要となるため低線量域の

精度確保は重要となるが線量計の感度に起因する精度低下が懸念される。この場合、モニタリング

線量計と X 線管の距離を近づけるなどしてモニタ線量を十分にする。 

 加えてタイムスケール法では、タイマの設定可能な範囲のみで DR システムのダイナミックレン

ジ全領域をカバーすることは困難である。この場合は距離を変化させ露光レベルを変えることで 2

つの入出力特性を測定し、これらをつなぎ合わせる。また、距離が可変できない装置ではフィルタ

厚を変化させる。この場合、X 線質が変わるため照射線量と入射量子数の関係を用いることができ

ない。よって RQA5 などの規定の線質のフィルタにて十分な線量範囲を規定のフィルタでデータ取

得し、それ以外の線量域はフィルタ厚を変化させて測定する。 

 

Fig.1 入出力特性の配置図 
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４．Presampled MTF 

システムの解像特性は、出力画像の鮮鋭性を決定する因子であり非常に重要である。システムを

介して出力された画像は、ほぼすべての場合で解像度の劣化が生じボケを伴う。このためシステム

の画質を評価する上で解像特性を正確に評価することは重要であり、以前より様々な方法によって

評価が行われてきた。しかし、観察や測定方法によって評価結果が変わるなど問題が生じ、現在で

は放射線画像の評価には空間周波数領域で評価を行うレスポンス関数である変調伝達関数

（modulation transfer function：MTF）を用いることが一般的である。 

 

MTF の定義には以下の 2 つがある 

① 点像強度分布 or 線像強度分布のフーリエ変換 

② 正弦波の振幅比 

 

本稿では①について解説する。1 次元にて線像となるデルタ関数を入力すると、システムを介した

出力信号はほぼすべての場合においてボケを表す拡がりをもつ線像となる。これを線像強度分布

（line spread function：LSF）といい、LSF に 1 次元フーリエ変換を行い、絶対値化、正規化の過

程を経て MTF が得られる。 

 MTF を用いるためには測定対象のシステムが線形性と位置不変性を満たすことが必要となる。こ

のうち線形性については前章で解説した入出力特性からディジタル値を露光量に変換することで線

形性を担保することができる。また位置不変性とは画像上、どこでも同じ性質を持つことをいう。

ディジタルシステムの場合、入力信号が不変であっても信号とサンプリング点の位置関係によって

は出力信号が変化するため位置不変性は成立しない。そこで DR システムにおいてはサンプリング

以前のアナログ成分の解像特性を表した presampled MTF が主となっている。この presampled MTF

はサンプリング間隔の影響を受けず、エリアシング誤差を含まないためナイキスト周波数以上まで

も評価が可能である。 

   ①の定義を用いる presampled MTF の測定法にエッジ法がある。エッジ法は IEC が DQE の測定方

法を標準化したなかで MTF の測定法として採用された。エッジ法の原理は線形システムにステップ

信号を入力し、システム通過によってボケを生じたエッジ拡がり関数（edge spread function：

ESF）を取得後、この ESFを微分することで LSF に変換するものである。測定デバイスについては

IEC62220-1 に 1 mm 厚のタングステンを推奨する旨が記載されている。Fig.2 にエッジ法における

測定ジオメトリ、Fig.3 にエッジデバイスの配置の 1 例を示す。 

    

 

 

 

 

 

 
Fig.2 エッジ法のジオメトリ 

Fig.3 エッジデバイスの配置 
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  X 線管の焦点と検出器間の距離は可能な限り 1500 mm 以上とすることが望ましい。また、リーダー

タイプのシステムではディテクタ前面にあるカバーや天板、フォトタイマなどは可能な限り取り除

くようにする。 

   デバイスの配置について、実効サンプリング間隔が十分に小さい合成プロファイルを取得するこ

とを目的に、エッジデバイスを検出器に対して 2～3°程度傾けて配置する。この理論は良書を参照

いただきたいが、角度を正確に測定することが精度の良い presampled MTF の取得に直結する。少

なくとも 2 方向の presampled MTF を取得することが望ましいが、CR システムにおいてはスキャン

方向でのエッジデバイスの向きによってプロファイルが変化することから 4 方向の測定を行うべき

である。 

   データ取得の際の X 線質は IEC が定めたものを用い、照射線量は画像の直接線領域のディジタル

値が最大ディジタル値の 50～80％程度となるよう設定する。 

 

５．NNPS 

   粒状とは画像を観察したときに感じる不規則なざらつきのことを指し、その性質をノイズ特性あ

るいは粒状性という。ノイズ特性の評価はノイズの空間周波数成分をパワースペクトルで表すノイ

ズパワースペクトル（noise power spectrum：NPS）を用いて行われており、特に DR システムのノ

イズ特性をノーマライズドノイズパワースペクトル（normalized NPS：NNPS）という。 

   ノイズ特性の評価法として NNPS の他に RMS 粒状度や自己相関関数がある。RMS 粒状度は測定資料

にトレンドがあると正確な値を求めることはできず、また空間周波数の関数ではないため異なるシ

ステム間の比較には不向きである。NNPS はノイズレベルを空間周波数ごとに評価できるだけでな

く、DQE の算出式内にも値が用いられるなど、非常に有用なノイズ特性の評価項目である。DR シス

テムでは撮影線量のブレに対し、感度補正がはたらくなどの理由で画像の濃度やコントラストを一

定に保つことができる。しかし、線量不足の場合、ノイズ特性の悪化は避けられず診断能の低下を

招く。よって、画像のノイズ特性は適正線量決定の根拠となり、その理解は非常に重要である。 

  Fig.4 に NNPS 実測時の配置を示す。 

   

NNPS のデータは、入出力特性のデータは照射線

量が既知であることから、これを利用するのが

望ましい。したがって基本的には入出力特性の

配置図と同様になる。ただし、IEC62220 シリー

ズでは総解析画素数を 400 万画素以上必要とし

ているため、ディテクタの照射範囲および解析

範囲とピクセルサイズから、1 画像あたりの解析

画素数を決定し、必要枚数を調整する必要が

る。 

 

 Fig. 4 NNPS 実測時の配置 
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５．まとめ 

   本稿では DQE 算出に必要な入出力特性、preampled MTF、NNPS におけるデータ取得時の注意点と

工夫について IEC62220 シリーズを基に解説した。現在、一般撮影領域において、使用される検出

器は computed radiography システムから FPD へ置き換わっている。新システムを導入する都度に

DQE を取得しておけば、次回更新時における線量設定の大きな根拠となる。しかし、DQE はその

「精度」が大事であり、これを担保するには各測定時の正確性と結果の解釈が必要である。 

 

 

参考文献 

 ・IEC62220-1：Medical electrical equipment-Characteristics of digital X-ray imaging 

devise part1：Determination of detective quantum efficiency, International 

Electrotechnical Commission, 2003 

 

 ・桂川 茂彦編, 桂川重彦, 藤田広志, 杜下淳次, 他著：医用画像情報学, 南山堂, 2002 
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DR システムの出力データ形式と取り出し方 

日本医療科学大学 保健医療学部 診療放射線学科 今花 仁人 

 

1. はじめに 

ディジタルラジオグラフィシステム（以下 DR システム）の普及により,現在多くの臨床施設におい

て単純 X 線画像はディジタル化され,その恩恵は計り知れないものがある. 

画像の物理評価に関して言えば,増感紙−フィルムシステムでは,フィルムに出力された濃度（アナロ

グ信号）をディジタル信号へと変換するためのマイクロデンシトメータなど高価な装置が解析に必

要であった.したがって物理評価は開発に関わる研究者など一部の限られた施設でしか行えなかっ

た.DR システムでは出力されたディジタル信号を市販のコンピュータなどを用いることによって,誰

もが解析が可能となった 1).このように画像の物理評価に対する敷居が低くなったことは,ディジタ

ル画像の基本的な特性を把握し日々の検査に臨むユーザにとって大変重要な意味を持つ.今日まで多

くのセミナーや勉強会を通して物理評価の解析方法は広く普及している. 

しかし解析する際のデータ形式が間違っていたために,解析結果が無駄になってしまう場合や解析結

果を誤って理解してしまう場合がある. 

本講座では DR システムの物理評価を行うにあたり,解析に用いるデータに関する注意点を述べる. 

 

2. 線形システム 

ディジタル画像の物理評価は,評価するシステムが線形システムであることを前提としている. 線形

システムには入力と出力が存在し,それらの間には以下の関係が成り立つ. 

① 入力を𝑐𝑐倍したとき,出力も𝑐𝑐倍となる. 

② 入力が f1(x)のときの出力を g1(x),入力が f2(x)のときの出力を g2(x)とすると, 

入力が f1(x)+ f2(x)のとき,その出力は g1(x)+ g2(x)となる. 

例えばいま,検出器のある位置 x において,X 線露光量を f(x),出力されるディジタル値を g(x)とする

と,線形システムであれば X 線露光量が𝑐𝑐倍となると出力されるディジタル値も 𝑐𝑐 倍となる.またこ

のシステムの出力は個々の入力に対する出力の和となる 2)3).(Fig.1) 

画像部会 
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Fig.1 線形システム 

 

よくある誤解として,出力の g(x)が g(x)=af(x)+b といった切片を含んだ関数となった場合, g(x)と f(x)

がグラフでは直線関係にあるため線形システムだと思われがちだが,前述の線形システムの条件であ

る「システムの出力は個々の入力に対する出力の和」を満足していないため線形システムとはなら

ない (Fig.2). 

 

 

Fig.2 切片を含んだシステム 

 

物理評価を行うにあたっては,出力されたデータが線形性の条件を満たしていることが重要であり,

評価するシステムが線形システムである事によって初めて MTF などの数学的解析手段が応用できる

事となる. 
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3. raw データ 

Fig.3 にフラットパネルディテクタ（以下,FPD）のディテクタ信号が出力画像となるまでの概略を

示す. 

 

Fig.3 FPD におけるデータ出力の流れ 

現在市販されている FPD から出力可能な物理解析に用いる raw データとしては IEC62220 シリーズの

定める RAW データ,ORIGINAL データ,Log データに大別される 4). 

RAW データはディテクタ信号が A/D 変換された直後のデータであり,一般にユーザで取得することは

困難である.また補正の掛かっていない状態のデータであるため解析に用いる場合,必要に応じてデ

ィテクタ補正などを行う必要がある. 

ORIGINAL データは欠損ピクセルの置換やピクセルのオフセット補正など FPD の均一性に関わる種々

のディテクタ補正がかかった状態であり,解析に用いやすいという利点がある.またこの段階では露

光量に対してディジタル値は線形に変化しており,前項の線形システムの条件を満足していることか

ら,ディジタル値をそのまま解析に用いることができる. 

Log データは対数アンプ回路を通過した後のデータであり,出力されるディジタル値は対数に変換さ

れている.この段階で前述の「システムの出力は個々の入力に対する出力の和となる」という線形シ

ステムの条件を満たさなくなり,このシステムは Logシステムと呼ばれる.(Fig.4). 
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Fig.4 Log システム 

Log システムから出力されたデータに対して物理解析を行う場合,入出力特性の傾き G を用いてディ

ジタル値を有効露光量に変換する線形化が必要となる. 

装置からこれらの raw データ出力が不可能である場合,ユーザ側で可能な限りの非線形処理を外

し,Look up table(LUT)を装置のダイナミックレンジ全てに掛かる直線階調とすることで raw データ

に近い状態で出力することができる.しかし本来の raw データとは異なるため入出力特性などでデー

タの特性を確認しておく必要がある. 

また,いずれのデータにおいても入出力特性のグラフに切片を含む場合や,低露光部において非線形

となる場合などもある.これらは解析精度を低下させる要因となるため物理評価を行う際は,一度正

確な入出力特性を測定しておくことが望ましい. 

 

4. 非線形処理の例 

物理解析を行うにあたり,自身の扱うデータが線形であることの確認は重要である.しかし実際には,

ユーザ側で確認不可能な非線形な関数が出力データにかけられている場合なども多く存在する. 

その一例として,digital imaging and communications in medicine (DICOM) の Part14 に規定さ

れた grayscale standard display function(GSDF)を紹介する.GSDF は人間の視覚特性に基づいた

Barten モデルから導出されたディジタル画像の表示関数である.この関数は横軸が輝度に対する視

覚の弁別閾 Just Noticeable Difference（JND）で表されており,人間の視覚特性は輝度に対して非

線形な反応をするため GSDF は非線形な関数となる 5).この GSDF によって変換を受けたディジタル値

は presentation value (P-Value)と呼ばれ,当然非線形なものとなる(Fig.5). 
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Fig.5 GSDF 

モニタ診断が普及した現在において,GSDF によって変換された P-Value はモニタを含む表示デバイ

スの階調特性を統一するために大変有用なものであるが,物理解析においては線形性の条件を満たさ

なくなる.物理解析の際はシステムから出力されるディジタル値が光学濃度に対して線形な値（相対

濃度値）に切り替えておかなくてはならない.しかし装置によっては P-Value の出力のみしか対応し

ていない機種も存在するため,あらかじめ確認しておく必要がある. 

 

5. おわりに 

物理解析は様々な特性を客観的な数値として比較できるため,装置の性能の把握や撮影条件の決定な

ど様々な場面で有用である.しかしその結果は正しいデータによって正確に導き出されたものでなけ

れば数値だけが独り歩きしてしまう事にもなりかねない.日頃,解析方法や結果にばかり目を向けて

しまいがちだが,自戒も込めて解析前に取得したデータの特性を十分検討していきたい. 
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4) 日本放射線技術学会 監修: 標準 ディジタル X 線画像計測, オーム社, 2010.  

5) DICOM PS3.14, Digital Imaging and Communications in Medicine (DICOM) Part 14: Grayscale 

Standard Display Function.  
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物理評価のピットフォール 

- Presampled MTF とサンプリング，非線形への対応 - 

鈴鹿医療科学大学  東出 了 

 

1. Presampled MTF とサンプリング 

1-1. Presampled MTF の理解 

 システムの解像特性評価には modulation transfer function (MTF)が用いられる．この MTF を適用

する上での前提条件として，「線形性」と「位置不変性」がある．このため，ディジタル値と線量が比

例関係とならない digital radiography (DR)システムでは，「線形性」を満たすために「線形化（有効

露光量変換）」が必要となる．また，DR システムでは同じ入力信号を用いてもサンプリング位置によっ

て出力画像の変化が起こるため「位置不変性」は成り立たず，「位置不変性」を成立させるためにサン

プリング間隔を非常に小さく設定した presampled MTF での評価が必要となる．Presampled MTF の評価

には，使用するデバイスを 1.5～3.0°程度傾けて画像を取得する必要がある．1), 2)わずかに傾いたデ

バイスは検出器におけるピクセルとの位置関係が各行で異なるため，各行のデータをデバイスの傾き

角度に応じた位置補正を行うことでデータの合成が可能となり，非常に細かい間隔のデータを取得す

ることができる．この非常に細かい間隔のデータを用いることで DRシステムにおいても「位置不変性」

を満たすことが可能となる．なお，金属であるタングステン（1.0 mm 厚）をデバイスとして用いたエ

ッジ法が International Electrotechnical Commission (IEC) より推奨されている．3, 4)現在，エッジ

法は日本でも DR システムの解像特性（presampled MTF）評価の方法として最も使用されており，DR セ

ミナーや研究発表など本学会においても東出らの解析方法が用いられている．5) 

 算出された presampled MTF は，図１のように X 線検出器のボケとサンプリングアパーチャのボケを

含んだ MTF を表し，ディジタル化される前のアナログ成分の MTF を意味する．物理評価における解像

特性を正しく理解する上で，presampled MTF の位置付けを理解することは非常に重要である． 

 

 

図 1  ディジタル X 線画像システムにおける presampled MTF 

画像部会 
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1-2. Presampled MTF とサンプリング 

 今回，異なるサンプリング間隔での画像出力が可能な検出器である Konica Minolta 社製の AeroDR 

fine 1417HD（以下，AeroDR fine）を用いた．間接変換方式 flat panel detector (FPD)である AeroDR 

fine の presampled MTF を算出するため，エッジ法にて RQA5 の線質で画像を取得した．取得したサン

プリング間隔が 0.200 mmと 0.100 mm のエッジ画像から解析した垂直方向の presampled MTF の結果を

図２に示した．両者の presampled MTF の結果はほぼ同等であったが，約 1.5 cycles/mm より高い空間

周波数において 0.100 mm間隔の presampled MTF の結果が高い値を示し，0.200 mm 間隔の方がやや低

い値となった． 

Presampled MTF は間接変換方式 FPD の X 線検出器（蛍光体層であるシンチレータ）と画像読み取り

部（サンプリングアパーチャ）の解像特性を示す．今回のデータは同じシンチレータを使用することか

らアナログ MTF は同じである．0.100 mm と 0.200 mmの画像は 1×1 ピクセルと 2×2 ピクセルのデータ

を用いて画像が作成されている．このため，画像読み取り部（サンプリングアパーチャ）の大きさは異

なることになり，アパーチャ MTF は異なるといえる．図 2 の結果の違いについて原因を確認するため

に，0.100 mm 間隔の結果に対して sinc 関数によるアパーチャ MTF の補正を付加して 0.200 mm 間隔に

相当する presampled MTF を算出した結果を図 3 に示す．補正後の結果と実測した 0.200 mm 間隔の

presampled MTF はほぼ一致しており，アパーチャ MTF の違いが図 2 の結果の違いであることが確認で

きた．今回の presampled MTFの結果から理解すべきポイントは，サンプリング間隔の違いが presampled 

MTF の結果の違いとなった訳ではなく，サンプリングアパーチャの大きさが異なることによって

presampled MTF の結果に違いが生じた点である． 

 

図 2  異なるサンプリング間隔における間接変換方式 FPD の presampled MTF 
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図 3  アパーチャ MTF を考慮した補正後の presampled MTF との比較 

 

次に，サンプリング間隔の違いによる画像への影響を確認するために，同検出器と散乱 X 線除去用

グリッド（3:1, 40 本/cm）を使用して膝ファントムと矩形波チャートを撮影した．なお，エリアシン

グの影響も確認するためにグリッド縞除去処理は使用せずに画像を出力した．0.200 mm と 0.100 mm の

サンプリング間隔による画像への影響を確認するために，図 4 に膝ファントムの腓骨近位部の画像，

図 5 に矩形波チャートの画像を示した．両者ともに 0.100 mm 間隔の画像の方が細かい部分の情報まで

視認することが可能である．サンプリング間隔が小さい方がより細部まで表現が可能となっているこ

とがわかる．ここで理解すべきポイントは，画像の見え方の差は presampled MTF の違いだけではなく，

サンプリング間隔の影響が含まれている点である．1-1 で前述したように，presampled MTF は X 線検

出器のボケとサンプリングアパーチャのボケを含んだ MTF を表し，ディジタル化される前のアナログ

成分の MTF を意味し，サンプリングされる前の解像特性を示している．このため，presampled MTF が

同等の場合でもサンプリング間隔が小さい方が情報量は多くなることで，より細部まで表現が可能と

なる． 

次に，サンプリング間隔の違いによるエリアシングの影響を確認するために，図 6 にグリッド縞の

画像を示した．0.200 mm，0.100 mm 間隔の画像ではナイキスト周波数がそれぞれ 2.5 cycles/mm，5.0 

cycles/mm となる．このため，40 本/cm のグリッド縞は 0.200 mm 間隔の画像ではエリアシングエラー

が生じ，低空間周波数の信号として表現されていることが確認できる．このように，サンプリング間隔

の違いはエリアシングにも影響を及ぼしていることが理解できる． 
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図 4  膝ファントムの腓骨近位部の画像 (a) 0.200 mm 間隔， (b) 0.100 mm 間隔 

 

 

図 5  矩形波チャートの画像 (a) 0.200 mm 間隔， (b) 0.100 mm 間隔 

 

 

図 6  グリッド縞の画像 (a) 0.200 mm 間隔， (b) 0.100 mm 間隔 

 

1-3. まとめ 

 前述の 1-1, 1-2 より，両者の presampled MTF の結果は，約 1.5 cycles/mmより高い空間周波数に

おいて 0.100 mm 間隔の方が高い値を示したが，両者の差はアパーチャ MTF の違いであることが確認で

きた．膝ファントム画像と矩形波チャート画像を確認すると，両者ともに 0.100 mm 間隔の画像の方が

細かい部分の情報まで視認することが可能であり，サンプリング間隔が小さい方がより細部まで表現

が可能となっていることがわかる．また，エリアシングの影響もサンプリング間隔によって変化するこ
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とが確認できた． 

以上より，presampled MTF がほぼ同等の場合においてもサンプリング間隔が異なると，画像の見え

方，エリアシングの影響は異なることに注意が必要である．DR システムの物理特性の１つである解像

特性を理解する上で，presampled MTF の意味や位置付けを十分に理解することが重要となる．これら

を理解した上で presampled MTF の結果を確認し，DR システムの解像特性を評価することが大切とな

る．DR システムでは「presampled MTF」と「サンプリング間隔」の関係が非常に重要であり，画像の

鮮鋭性や虚像（エリアシングエラー）の影響を変化させ，画質を決定することになる． 

 

 

2. 非線形への対応 

2-1. 物理評価における線形性の重要性について 

DR システムの物理評価を行う上で，入出力特性の評価は非常に重要である．入出力特性を明らかに

することで，検出器の直線性・ダイナミックレンジ・階調数・最高ディジタル値などを把握することが

できる．特に，入出力特性の評価として最も重要なポイントは「検出器における線量（入力値）とディ

ジタル値（出力値）の関係」であり，X 線発生装置をコントロールして検出器への入射線量を正確に管

理した上で評価することが必要である．物理評価は「線形性」を満たすことが重要であり，「線量とデ

ィジタル値が比例関係にあること」もしくは「ディジタル値を線量に変換できる関係であること」を確

認することが必須となる．また，リニアシステム（線量とディジタル値が比例関係にあるシステム）で

も図 7 のような場合には注意が必要である．(a)では，線量（入力信号）が 0 の際にディジタル値（出

力信号）が b となるため，切片値 b を全体に減算する必要がある．(b)では，低線量領域において非線

形となる部分があるため，有効露光量変換による線形化が必要となる． 

   

図 7  線形化の処理が必要となるリニアシステム  

(a) 切片が 0 とならないケース， (b) 低線量領域において非線形となる部分があるケース 

 

 前述したように物理評価は「線形性」を満たすことが重要であり，解像特性評価で用いる presampled 

MTF やノイズ特性評価で用いる normalized noise power spectrum （NNPS）において理論的に「線形

性」を満たすことが必須となる．ログシステムの同一画像データに対して線形化に用いる入出力特性の

傾きを 700, 1024, 1300 と変化させた場合の presampled MTF の結果を図 8，NNPS の結果を図 9 に示
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す．このように，非線形データの場合において正確な線形化を実行できなければ，presampled MTF や

NNPS の結果は誤った値となって算出される．Presampled MTF や NNPS が正しく評価されなければ，両

者を用いて算出される noise equivalent number of quanta (NEQ)や detective quantum efficiency 

(DQE)も誤った評価結果となってしまう．このため，DR システムの物理評価では正確な線形化を実施す

ることが重要であり，入出力特性を正確に評価するために線量測定や画像取得に時間を掛けて正確か

つ慎重に実施することが必要となる． 

 

図 8 線形化のエラーを伴う                    図 9 線形化のエラーを伴う NNPS の結果 

presampled MTF の結果 

  

2-2. 非線形対応へのヒント 

2-1 にて前述したように理論的に物理評価は「線形性」を満たすことが重要である．しかし，現在の

DR システムの画像処理には非線形処理が多く用いられるため，画像処理に対する評価を実施するため

に非線形への対応が望まれている．CT 分野では非線形に対する評価が既に行われており，タスクベー

スによる MTF 評価を導入した Richard らの方法 6)が用いられている．このように他分野からの導入が

非線形対応へのヒントとなると考えている． 

現在，筆者らは DR 分野における非線形に対応する解析方法を確立するために検討を行っている．DR

システムに適した解析方法の確立が必要であり，精度や確度の高い評価方法を確立できるように進め

ている．今回の画像部会では発表できる段階にないが，なるべく早い段階で評価方法を発表できるよう

に努めていきたい． 

 

2-3. まとめ 

 理論的に物理評価は「線形性」を満たすことが必須であり，presampled MTFや NNPS，NEQ，DQE を正

確に評価する上で重要である．これらの理論を理解した上で，非線形システムや非線形処理に対する評

価を確立し，各システムや各処理に対して評価をしていくことが大切である．現在，筆者らは DR シス

テムにおいても非線形対応の評価方法の提案を準備している．新たな評価方法を発表し，多くの研究者

と評価方法について議論できる機会を楽しみにしている．ご期待頂けると幸いである． 
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物理評価のピットホール 

-DQE と線量，物理評価と臨床画像- 

東海大学医学部付属八王子病院 診療技術部放射線技術科 由地良太郎 

1.はじめに 

一般撮影領域におけるディジタル化は CR が登場してから急速に進み, 現在では CR から FPD への完全

移行も進んできている. 装置更新などにより検出器が変わる際, 我々放射線技師が留意する点は線量と

画質であり, 装置の持つ能力や特徴の評価が重要である. 医用 X 線画像の評価方法として検出量子効率

(detective quantum efficiency : DQE)や雑音等価量子数(noise equivalent quanta : NEQ)の算出方

法は国際電気標準会議(International Electrotechnical Commission : IEC)から発表された IEC 

62220-11),2)にも記載されており, 近年では DR セミナーや論文により物理評価の方法や理論を学習しや

すい環境である. そのため DQE は X 線撮影装置の評価項目として多くの施設で算出されており, 近年で

は X 線検出部の評価として用いられる NEQ を算出している施設も多い. この２つの評価項目は信号雑音

比(signal-to-noise ratio : SNR)や入力と出力のゆらぎの概念から導かれた尺度であり, 本稿では数

字だけが一人歩きしないよう意味も踏まえて理解が深まるよう述べていきたいと考える.  

また, DQE を用いて撮影線量の検討が行われているが, DQE 算出における画像取得をする際に撮影線

量を意識していないことが散見される. 本稿では DQE を算出する際の撮影線量に関する留意点を述べ

る.  

 

2.DQE,NEQ の定義 

DQE は医用画像で広く用いられている雑音に対する信号の割合を表す SNR で定義され, 入力と出力の

SNR の二乗の比で定義される. また, NEQ は出力の SNR の二乗で定義されている.3),4)  

 

 

 

 

また, Fig.1 に示すように画像システムを介して得られる SNR の二乗の比が DQE とも考えることもでき

る. 定義にあるように DQE,NEQ を理解するには, まず SNR の理解が必要不可欠である. 画像システムに

おいては入力と出力があるが, まずはそれぞれを分けて述べていく.  

画像部会 
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Fig.1 DQE,NEQ の定義の概念図 

  2-1.入力の SNR 

    放射線画像システムにおいて Fig.1 の入力に当たるのは X 線フォトンそのものである. X 線の発生

は時間的にも空間的にもゆらぎがあり, ポアソン分布に従うと言われている. ポアソン分布とは二項

分布の極限であり, 確率が小さく, 数が多い場合に起きる確率分布である. ポアソン分布は「単位時

間(空間)あたりに平均λ回起こる現象が, 単位時間(空間)に k 回起こる確率」を表すのに用いられ, 

以下の式で表せられる.  

 

  

 

ポアソン分布の特徴としては平均値(期待値)と分散がλになることである. ここで SNR の概念に戻る

と信号値は平均値, 雑音は分散の平方根である標準偏差となるため SNR は√λとなる.  

 

 

 

つまり, λが大きいほど SNR は大きくなるということになる.  

放射線に置き換えて考えると, 単位面積当たりにカウントされるフォトン数が q であった場合, その

量子のゆらぎである分散は q となり, 標準偏差は√q となる. SNR における信号値はフォトン数であ

り, 雑音は分散の平方根である標準偏差であるため, SNR の二乗はフォトン数と同じになる.  

 

 

 

 

 

よって, 入射してくる X 線すなわち入力の SNR の二乗はフォトン数と一致することがわかり, フォト

ン数が大きいほど SNR は大きくなり, 雑音の割合は少なくなっていくため, 良好な SNR を得るにはあ

る程度のフォトン数が必要であることが理解できる.  

信号値 

標準偏差 

入力の信号値 
入力の標準偏差 
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  2-2.出力の SNR 

次に出力の SNR について述べる. 放射線画像システムにおいて出力に当たるのは画素値であり, 出

力の SNR は入力時と同様に平均値と標準偏差の比で定義される. ここで注意すべき点として画素値は

画像システムによりディジタル化された段階でフォトン数とは全く異なる数字となるため, のちの

DQE を定義する上で問題が生じる. そのため, 画素値をそのまま扱うのではなく, 入出力特性を用い

て露光量に変換する必要がある.  

 

 

 

 

 

 

 

 

ここで, 出力である X 線画像のノイズ特性の評価で用いられている NNPS(normalized noise power 

spectrum)を考える. NNPSは「信号値を 1 に規格した場合のノイズゆらぎ成分の標準偏差の二乗値」

で定義されるため信号値と雑音の関係式となっており, 一様領域で変動する画素値を露光量に変換し

た値の平均値とその単位面積あたりのゆらぎである標準偏差を用いて, 以下の式で求められる.  

 

 

 

 

露光量の平均値を平均フォトン数とし, 露光量の変動をフォトンの変動と仮定したノイズ特性の指標

となる. ここで出力の SNR の二乗と比較を行うと NNPS の逆数になっていることがわかる. また, 画

像から求める NNPS は MTF(modulation transfer function)によって変調された画素値に基づいてお

り, NNPS は二乗の単位を持つため出力の SNR の二乗は以下の式のように表せられる. ここ示す MTF は

presampled MTF を表し, システムの解像特性の評価として用いられている指標である.  

 

 

 

 

 

出力の信号値 

出力の標準偏差 

露光量の平均値 

露光量の標準偏差 

出力の信号値 

出力の標準偏差 露光量の標準偏差 

露光量の平均値 
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  2-3.DQE,NEQ 

定義に戻ると DQE,NEQ は入力と出力の SNR の二乗で表されるため, 以下の式になる.  

 

 

 

  本来は空間周波数の関数として表されるが, 今回は省略している. 上記式で気をつけるべきはあく

まで算出するための式であることである. MTF や NNPSを用いるため解像特性とノイズ特性を兼ね備

えた評価指標と思いがちであるが, 本来の定義としては SNR の二乗値であり, 入力と出力のゆらぎ

を表している. また, 入力のゆらぎがフォトン数になることから NEQ が出力のフォトン数を表し, 

DQE がフォトン数の伝達特性と勘違いすることがある. DQE は入力と出力のゆらぎの比であり, SNR

の概念で考えた場合これまでの式が成り立つということである. 画像システムにおいてはフォトン

数そのものが画素値となるわけではなく, 検出効率やノイズ因子によって入力とは異なる結果とな

る. 入力の SNR では雑音はポアソン分布から考えられる量子ノイズのみを考慮したが, 画像システ

ムを介するため量子ノイズ以外の付加ノイズが加わりノイズ量が変化する. そのため DQE はあくま

で量子ノイズのみを考慮した場合に成り立つため, 実際の画像システムにおいては様々なノイズが

発生するため, このような簡単な式にはならないとことに注意が必要である. 4) 

 

3,異なる線量における DQE 

上記で述べたように実際の画像システムにおける DQE が撮影線量によって変化するのを確認するた

めに, NNPS の撮影線量を変化させ異なる線量における DQE を算出した(Fig.2).  

(a)                                            (b) 

Fig.2 異なる線量における DQE  (a)RQA3  (b)RQA7 

使用した装置は Konica Minolta 社製の AeroDR(1417HD)であり, 線質は(a)RQA3 と(b)RQA7 を用い

た. presampled MTF はエッジ法を用い, 高露光部のピクセル値がシステムの最高ディジタル値の約

50%〜80%になるような線量で取得し, NNPS は FPD への到達線量が約 1mR(8.67μGy)になる線量を基準

30



線量とし, 1/10 線量, 1/3線量, 1.5 倍線量, 2 倍線量で画像取得を行った. RQA3 では線量によって

DQE が異なっているが, RQA7 では線量による大きな変化は見られなかった. これは理想的なシステム

を想定して量子ノイズのみを考慮した DQE の定義と量子ノイズ以外の様々なノイズが加わる実際の装

置との違いだと考えられる. 

 

DR におけるノイズ分析は入出力特性で用いる均一露光画像のピクセル値から求めることが可能であ

る. 量子ノイズのみである理想的なシステムにおいてはポアソン分布に従うため, 線量に比例するピ

クセル値とその分散は比例関係になる. しかし, 実際の画像から露光量変換したピクセル値と分散の

関係を見ると緩やかな曲線を描くことになる(Fig.3).  

 

 

 

 

 

 

 

                

(a)                                           (b) 

Fig.3 ピクセル値と分散の関係  (a)理想的なシステム  (b)実際のシステム 

 

この原因は量子ノイズ以外の構造ノイズや電気ノイズによる影響である. 量子ノイズ(σquantum)はピク

セル値の平方根に比例し, 構造ノイズ(σstructure)はピクセル値に比例し, 電気ノイズ(σelectronic)はシス

テム固有の値を待つためピクセル値には依存しない. ピクセル値が線量に比例するシステムにおける画

像ノイズ(σ2
total)は次式が成り立つ. 5) 

 

 

また, 加法性と乗法性の性質から次の指揮が成り立つ.  

 

 

ここではαは量子ノイズの係数, βは構造ノイズの係数, γは電気ノイズの係数を表す. Fig.3(b)の

関係式から係数を求めることで, システムのノイズ成分の割合を求めることが可能である. 今回用いた

装置では取り出し可能な ORIGINAL DATA は対数変換後の画像であるため, 入出力特性の傾きから露光量

変換のデータを用い, 照射野中心に 100×100 ピクセルの ROI を設定し, ピクセル値と分散から求めた. 
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ピクセル値によってノイズ成分の割合が変化していることがわかる(Fig.4). また, 線質によって量子

ノイズの割合も異なることがわかる. 今回 NNPS 算出に用いた線量域は露光量変換後のピクセル値で表

すと約 100〜1000 であり, RQA7 では量子ノイズの割合が高いのに対し, RQA3 では電気ノイズや構造ノ

イズの割合が高い. DQE の定義が量子ノイズのみ考慮するため, 量子ノイズ優位な線量域では撮影線量

によって DQE は変化しにくいが, 構造ノイズや電気ノイズが優位な線量域では DQE の定義との乖離が生

じ, 線量によって DQE が変化すると考えられる.  

(a)                                        (b) 

Fig.4 ノイズ成分分析（百分率）  (a)RQA3  (b)RQA7 

 

4,臨床画像と物理評価 

上記のことから DQE を算出する際は検討する線量域を検討し, 画像を取得する必要がある. 実際に検

討する線量で撮影された臨床画像の ORIGINAL DATA のピクセル値がどの程度なのかを調査し, 物理評価

を算出する線量を決定することで臨床に用いられる線量での評価が可能である. しかし, DQE は定義か

ら考えると量子ノイズ以外を考慮していないため, あくまで効率としてとらえ, 出力のみを表す NEQ を

用いた方が画像評価としては適切であると考える. また, 物理評価のみで線量を決定するのは乱暴であ

るため, 画像処理を含めた視覚評価や臨床目的に応じて評価することが重要である.  
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無線動画（シリアル）撮影機能を搭載した回診用 X 線撮影

装置「AeroDR TX m01」の特長 

コニカミノルタ株式会社ヘルスケア事業本部モダリティ事業部 佐藤 朋秀 

 

１．はじめに 

現在、世界的な COVID-19 の蔓延もあり、感染症予防対策のための隔離病棟や集中治療室（以下

ICU）に入院している重症患者の診断および病態管理を行うため、回診用 X 線撮影装置の重要性が再

認識されている。重篤な患者の場合、CT などの高度な検査が必要とされることもあるが、患者の移送が

必要となり、病態管理や感染症予防対策の観点からそれが困難となるケースもあることが一つの要因で

ある。 

コニカミノルタでは、画像診断領域において広く利用されている単純 X 線撮影装置に着目し、従来の

静止画から得られる情報量を大きく増大させる動画（シリアル）撮影技術を確立、一般 X 線撮影装置を

用いたデジタル X 線動画撮影システムを実現した。さらに本年 3 月には、ベッドサイドでの無線動画撮

影を可能とし、患者の移送なしにより多くの情報を提供し得る回診用 X 線撮影装置「AeroDR TX m01」

[1] を発売、X 線動画撮影のポータブル撮影領域への拡大を実現した。本稿では、この回診用デジタル

X 線動画撮影システム、無線動画撮影技術およびポータブル撮影に有用なアライメントサポート機能に

ついて紹介する。 

 

2．回診用デジタル X 線動画撮影システム 

 この回診用デジタル X 線動画撮影システムは、「AeroDR TX m01」とワイヤレスカセッテ型 DR

「AeroDR fine motion」 [2]との組み合わせにより、パルス X 線の連続照射（15 frame/sec）による無線動

画撮影に対応（図 1）、ベッドサイドにおいて臥位や座位での動画撮影を可能としている。 

 

図 1 無線動画（シリアル）撮影の概念図  

技術紹介 
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また、撮影された動画を X 線動画解析ワークステーション「KINOSIS」 [3]に転送することで、各種解析

処理およびその結果表示が可能となる（図 2）。 

 

図 2 動画撮影システムと X 線動画解析ワークステーションの概念図  

 

3．無線動画撮影技術  

これまでにコニカミノルタが開発したデジタル X 線動画撮影システムにおいては、一般 X 線撮影装置

と接続インターフェース、ワイヤレスカセッテ型 DR「AeroDR fine motion」の 3 つの機器が専用ケーブル

で接続され（図 3）、パルス X 線の連続照射と、FPD の画像読み出し動作のタイミングを同期している

（図 4）。 

図 3 動画撮影システム（有線）概略図  
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図 4 パルス X 線の連続照射における同期概略図  

 

一方、回診用 X 線撮影装置「AeroDR TX m01」では、有線接続と同等の精度で曝射タイミングの同

期が可能な無線接続技術を開発し、パルス X 線の連続照射による無線動画撮影に対応した（図 5）。

これにより FPD は静止画と同様に無線で使用可能となり、人工呼吸器や患者モニタリングシステム等の

様々な機器が患者に装着される ICU の環境においても、動線を確保した動画撮影が可能となった。 

 

図 5 動画撮影システム（無線）概略図   
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4．アライメントサポート機能  

「AeroDR TX m01」では、ベッドサイド撮影におけるポジショニング支援を目的とし、X 線管球と FPD

それぞれのロール角およびピッチ角の表示機能を搭載した。特に、ピッチ角においては、これらの数値

が一致した際、色付き表示することで X 線の FPD への斜入を防止、画像影響を最小限に抑えている。

(図 6)。 

 

図 6 X 線管モニタの表示  

 

それぞれの角度は、X 線管と FPD に搭載された 3 軸加速度センサーを用いて算出される（図 7）。ま

た、FPD においては 3 軸の重力加速度の大きさから FPD が縦を向いているか、横を向いているかを検

出し、縦横方向に合わせて FPD のロール角とピッチ角を切り替えることで、FPD の向きによらず X 線管

球と FPD のロール角とピッチ角を合わせている（図 8）。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 7 3 軸加速度センサーを使ったロール角とピッチ角の算出  
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図 8 パネル向きとロール角/ピッチ角の関係  

 

このアライメントサポート機能により撮影の再現性を向上させ、経過観察に適した画像の提供に貢献

することが可能である。 

 

5．おわりに 

コニカミノルタが開発したデジタル X 線動画撮影システムは、回診用 X 線撮影装置への動画撮影機

能搭載により一般撮影領域からポータブル撮影領域に拡大した。ポータブル撮影領域では、特に診断

や治療のための情報が限られる ICU において、従来の静止画以上の情報量を有する動画の提供を通

じ、病態管理により貢献することが強く期待される。 

今回紹介した「AeroDR TX m01」をはじめとするこのデジタル X 線動画撮影システムが、より有用性

の高い画像診断機器となるよう、今後も臨床価値の創出・検証および機器開発に取り組み、更なる医療

の質の向上に貢献してゆく所存である。 

 

 

[1] AeroDR TX m01 [販売名：移動型汎用 X 線装置  AeroDR TX m01（製造販売認証番号：第

303ABBZX00055000 号） ] 

[2]  AeroDR fine motion  [販売名：デジタルラジオグラフィー  SKR 3000（製造販売認証番号：第

228ABBZX00115000 号） ] 

[3] KINOSIS [販売名：画像診断ワークステーション コニカミノルタ DI-X1（製造販売認証番号：第

230ABBZX00092000 号） ] 
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CXDI-RF Wireless B1 における 

Built-in AEC Assistance 技術について 

 

             キヤノン株式会社 医療機器第三開発部 丹羽 宏彰 

                     メディカル第一事業企画部 佐嶋 一裕 

１．はじめに 

 キヤノンは、DR(Digital Radiography)方式のワイヤレス X 線デジタル撮影装置の新

製品として、“デジタルラジオグラフィ CXDI-RF Wireless B1”を 2021 年 8 月下旬に

発売した。新製品はフルサイズ（約 17×17 インチ）対応のワイヤレス X 線デジタル撮

影装置(※1)である。1 台で幅広い撮影手法や撮影部位に対応しているほか、可搬性に

優れた外装デザインでさまざまな撮影シーンでの作業負荷軽減に貢献する。また、キ

ヤノンの新技術「Built-in AEC Assistance」を採用する。 

「Built-in AEC Assistance」は、X 線イメージセンサーと同一面上に形成された、画

像検出用の画素と同一構造の検知用素子を用いて、画像生成と同時に、照射された X

線に相当する画素値をリアルタイムに検知することができる技術である。今回、「デ

ジタルラジオグラフィ CXDI-RF Wireless B1」の技術を紹介する。 

 

2．CXDI-RF Wireless B1 の特長：透視から一般撮影まで幅広い撮影手法に対応 

 DR 方式の X 線撮影手法として、バリウム等を使用し、X 線をパルス状または連続照射

することで体内を透過する際に生じる X 線のコントラスト差をモニターでリアルタイ

ムに動画のように観察する「透視」や、胸部や腹部、骨や関節などを静止画として撮

影する「一般撮影」などがある。本製品は 1 台で「透視」から「一般撮影」まで幅広

い撮影手法に対応する。本体質量は約 3.5kg で、持ちやすさを追求した外装デザイン

を採用しているため、撮影時の位置決めや片手での持ち運びを容易に行うことができ

る。撮影した画像は、専用コントロールソフトウエアにより素早く表示、確認が可能

で、多様な撮影ワークフローに対応する。 

※1 ワイヤレス撮影時は一般撮影のみ対応。 

技術紹介 
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3．新技術：「Built-in AEC Assistance」により多様な医療現場での撮影をサポート 

 X 線を用いて撮影を行う医療現場においては、「人体への X 線の照射は社会的・経済

的要因を考慮しながら、できるだけ少なくするよう努力すべき」という放射線防護の

基本的な考え方である「ALARA(※2)の原則」に基づき、さまざまな取り組みが行われ

ている。例えば、X 線撮影システムでの撮影に際しては、一般的に X 線発生装置から被

写体に対して過度に X 線が照射されないよう管理するため、照射された X 線に相当す

る電流を検知する外付けデバイスが使用されている。しかし、DR 方式の X 線撮影装置

などをシステムの撮影台から取り外してワイヤレスで撮影を行う場合等、外付けデバ

イスが使用できないケースがある。 

 この度、キヤノンは、長年にわたり培ってきた X 線センサー技術とイメージング技術

を生かし、従来、外付けデバイスが担っていた機能を撮影装置に内蔵させることがで

きる新技術「Built-in AEC Assistance」を開発した。新製品は、画像を生成すると同

時に、照射された X 線に相当する画素値をリアルタイムに検知する新技術「Built-in 

AEC Assistance」を採用している。これにより、システムの撮影台から取り外してワ

イヤレス撮影を行うような、外付けデバイスが使用できないシーンを含む多様な医療

現場で撮影をサポートする。 

 

 

 

※2 As Low As Reasonably Achievable の略。1977 年に国際放射線防護委員会により勧告された考え方。 

 

図 1：透視／一般撮影それぞれに対応可能な 
専用ソフトウエア（画面イメージ） 

40



 

 

 

 

4．Built-in AEC Assistance 技術について 

 新技術では、X 線イメージセンサー内の電気信号の高速読み出しや各種アルゴリズム

による画素値補正を可能にすることで、X 線イメージセンサーと同一面上に形成され

た、画像検出用の画素と同一構造の検知用素子を用いて、画像を生成すると同時に、

照射された X 線に相当する画素値をリアルタイムに検知する。 

 

 

 

 

 

１． はじめに 

  

 

図 2：新製品を使った X 線照射停止までの流れ（イメージ） 

 

図 3：X 線イメージセンサー内の素子構造（イメージ） 
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リアルタイム検知された画素値情報は、逐次累積され、さらに、基準値をあらかじめ

設定しておくことで、画素値の累積情報が基準値に到達した時点で X 線発生装置へ通

知することができるため、専用の外付けデバイスを使用することなく、X 線発生装置側

で X 線照射の自動停止が可能になる。 

 

 

 

5．おわりに 

 キヤノンは今後この技術を X 線デジタル撮影装置「CXDI」シリーズに搭載していくこ

とで、病院内における回診撮影を含む幅広い撮影シーンに対応できるよう製品開発を

進めていく。また、医療以外のさまざまな用途への応用も視野に入れた開発を進め、X

線センサー技術とイメージング技術をより一層進化させることでデジタル撮影領域を

拡大していく。 

 

＜主な製品仕様＞ 

 

販売名 デジタルラジオグラフィ CXDI-RF Wireless B1 
撮影方式 シンチレーター＋アモルファスシリコン（a-Si） 
シンチレーター 
（蛍光体） 

CsI（ヨウ化セシウム） 

画素サイズ 160μm 
有効撮影範囲 約 420×430mm 
外形寸法 約 460（幅）×460（高さ）×15.5（奥行き）mm 
質量 約 3.5kg（バッテリー含む） 
フレームレート 
（有線時） 

5fps（1×1） 
15fps（2×2 ビニング） 
30fps（3×3 ビニング／9×9 インチサイズ） 

I/F 有線：Gigabit Ethernet 
無線：IEEE802.11 a/b/g/n（2.4GHz／5GHz） 

医療機器認証番号 302ABBZX00058000 
 

図 4：Built-in AEC Assistance データフロー 
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オンライン医用画像処理プログラミングセミナー   

おうちで学ぶ初めてのディープラーニングを受講して 

松江市立病院 放射線部 岩坂 徹 

 

 近年医療技術にも多くの分野で AI 技術が用いられてきており、新卒の学生は大学で AI を習得した技

師が今後は増えていく流れになっていくと思われる。我々のような中間管理職の世代は若者のからの新

しい知識と、上司の古くからの経験と技術を融合しなければならない世代として、AI 技術の習得も必須

であると考えてきた。しかし、AI をやってみたいけど Python コードを習得していない自分にとってなか

なか敷居の高い分野でした。 

2 年前に Sony の開発した Neural Network Console（NNC）の存在を知り、独学で初めてみました。幸い

にもこのツールは導入コストが無料で、開発の Sony 社が You Tube にチュートリアルを含めた詳しい解

説動画や、ネットワーク型グラフィックボードの機能があり、 AI の構築も Graphical User 

Interface(GUI)により、プログラムコードを書かなくても構築が可能となっています。「やってみたいな、

けど始めるには PC を買わなきゃいけにないのかな」とか「やってみたいけど、コードを覚える時間がな

かなか作れないな」みたいな方にはお勧めのプログラムになります。個人で初めて見たのですが、やはり

自分一人で動画を見ながらやっていて、出来るようにはなっていくのですが、動画はやはり一般的な内容

が中心になっているので、放射線技師が医療画像をあつかって解析を行うには、細かい疑問が浮かんでく

るようになり、ここをもう少し効率的にしたいなという点が多く浮かんできました。 

そんな中でこの講座を診療放射線技術学会のホームページで見かけ、受講したいと思い応募しました。 

受講が受理されると、受講までの基礎知識の動画、NNC のインストールガイド、当日の授業の受講デー

タが配布されます。受講までに NNC のインストールを行う必要がありますが、インストールガイドも非常

にわかりやすい内容となっているために安心してインストールすることができます。NNC はウエブ型 GPU

を使用することも可能ですし、時間がかかるのですが、CPU での処理も可能となるので、本講座を受講す

るために新しい PC を購入する必要もありません（ちなみに私は「本講座を受講するのに AI の処理をす

るのに性能の高い GPU が必要だから」と言って PC の更新を行いました。）任意ではありますが、Slack へ

登録を行うと、掲示板機能を利用して事前に躓いたことや、わからないことを聞くこともでき、スタート

ラインに立つ前に挫折するという事はありません。また、事前学習である中山先生の深層学習の基礎の動

画講義は非常にわかりやすい講義です。受講までにきちんと見ておくことをお勧めします。また、2020-

2021 年版 標準 医用画像のためのディープラーニング: 入門編（オーム社）が基本テキストになるので、

こちらも一度読んでおくことで講習当日の講義内容をよりきちんと理解することができると思います。

事前のネットワークテストでネットワーク環境のチェックも行っていただけるので、Wi-Fi 等で受講をあ

まりお勧めはしませんが、受講中の接続状況も事前にシミュレートすることも可能です。 

受講当日は座学からはじまり、AI で行う研究の方法論で AI でのデータの収集方法とその工夫の仕方、

学習用の教師データの作成、AI の学習、解析、結果の評価と解釈方法までの内容を受講し、次に NNC の

読者のページ 
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基本操作と、説明までの講義を午前中に受講しました。講義の途中でも疑問に思っていたことはすぐに聞

くことができ、わからない事や疑問をうやむやにすることなく受講をすることができました。 

昼食後はハンズオンのセッションで、受講内容は「画像の分類」と「セグメンテーション」の二つでし

た。 

事前に配布されたデータを用いてデータセットの作成からネットワーク構築まで、各受講者に合わせ

たペースで行ってもらえ、躓いてもスタッフが画面共有を利用した個別指導を行っていただける為に非

常に親切な対応をしていただけます。午前中の座学で学んだ内容を盛り込み、学習パラメータの設定によ

る処理時間への影響や、結果への影響、出てきた結果の解釈など、非常にわかりやすい講義だと感じまし

た。 

2 つ目のハンズオンの題材は U-Net を用いたセグメンテーションの講習です。U-net は物体の自動抽出

等に利用される手法です。一つ目のハンズオンと同様に事前の配布データからデータセットの作成を行

い、ネットワークの作成を行いました。 

ハンズオンもサポートスタッフのおかげで脱落者もなく皆が最後まで行うことができました。 

受講後には当日の講義、ハンズオンの内容のレジメをいただくことができたので、講義では使用したデ

ータの画素数が小さいために、ネットワークの構造はシンプルなものでしたが、高画質なデータだったら

どうなるのか、また U-netの階層を深くしてやることでどうなるのか、それらについてもレジメを見直し

ながら、データセットは放射線技術学会の配布するものを使用して高画質なデータでデータセットを作

成し、浅い U-net から 5 階層の U-net まで構築し、その結果の違いや、学習パラメータの違いによる結果

の違いなど、本講座を受講するだけでいろいろなことを行うことができるようになれました。 

皆さんも是非ともこの講座を受講して、座学を通じて、ハンズオンを通じて新しいスキルを身に着けて

みませんか？現地セミナーとなると、家庭や勤務の制限が多い昨今ですが、Webハンズオンセミナーです

と、そのような制限もありません。 

最後に本講座の講師を務めていただけました篠原範充先生、寺本篤司先生、中山良平先生、田中利恵先

生、山本めぐみ先生、バックアップサポートをしていただけた藤田医科大学の寺本研究室のスタッフの皆

様に心より御礼申し上げます。 
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オンライン 医用画像処理プログラミングセミナー 

～おうちで学ぶ初めてのディープラーニング～を受講して 

九州大学病院 医療技術部 放射線部門 平山 亮太 

 

このたび，令和 4 年 7 月 17 日に画像部会主催で開催された「第 43 回医用画像処理プログラミングセ

ミナー ～おうちで学ぶ初めてのディープラーニング～」を受講させていただきました．以前からよく

耳にしていた「ディープラーニング」や「深層学習」といったものに興味はあったのですが，具体的に

どういったもので，どのように利用することができるのか，自分なりに調べてみてもいまいち理解でき

ていませんでした．そんな折，ハンズオン形式の第 43 回医用画像処理プログラミングセミナーの開催

を知り，一からディープラーニングに触れてみたいと思い，申し込むに至りました．今回参加報告をさ

せていただくにあたり，私と同じようにディープラーニングへの取っ掛かりを探している方の一助にな

れば幸いです． 

申込後数日が経過して受講が決定すると画像部会の先生から事前案内のメールが届きました．遠隔で

のハンズオンセミナーを円滑に実施するための事前準備に関するハンドアウトが送付され，受講日まで

のおよそ 10 日の間にハンドアウトに沿って準備をしました．事前準備の内容としては，深層学習の基

礎に関する動画の視聴，当日使用する Neural network console（NNC）のインストールと画像部会が公

開している深層学習用画像データセットのダウンロード，セミナー中のやり取りを円滑にするために使

用する slack の設定，Webex の接続テストがありました．事前準備で一番悩むことが多そうな NNC のイ

ンストールに関しては，手順を細かく示した動画を提供していただけたので，特に迷子になることも無

く，すんなりとインストールができました．なお，受講者 3～4 人に対して 1 人の担当チュータが割当

てられ，事前準備での不具合や不明な点に手厚く対応いただける体制が整えられていました．事前準備

の最後に受講者の状況把握のためのアンケートが用意されており，自身が深層学習に携わった程度やセ

ミナー当日に使用するハードウェアなどの環境に関して回答しました． 

セミナー当日は，推奨される環境に合わせて Webex 用の端末と作業用の端末を準備して受講に臨みま

した．10 時からセミナーが始まって最初に画像部会の講師の方々より自己紹介があり，つづいて受講者

の自己紹介がありました．自己紹介が一通り終わると，早速講義が始まりました． 

午前中に行われた講義では深層学習研究の方法論についてご教授いただきました．深層学習で必要と

なるハードウェアとソフトウェアについてや，使用するデータの準備方法，学習後の評価方法について

初学者にもわかるように易しくかつ詳しくお教えいただきました．中でも，私が興味を惹かれた内容は

深層学習で行えることをわかりやすく教えていただいた点と深層学習に使用できるさまざまなソフトウ

ェアを紹介いただいた点でした．深層学習で行えることについては，私が最も知りたかった部分であ

り，分類，領域抽出・物体検出，回帰（予測），画像生成・画像変換の 4 項目について例を挙げながら

読者のページ 
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ご講義いただけたので大変勉強になりました．また，今回の実習で使用したものは NNC でしたが，それ

以外の Tensorflow+Keras，Pytorch，MATLAB といったソフトウェアについても，実際に使用されている

先生方からそのソフトウェアの利点や欠点を交えながら紹介いただけたことは大変興味深く，ソフトウ

ェアに関する理解を深めることができました．ほかにも深層学習で使用するデータ数が少ないときの対

処方法などを教えていただいた点も大変興味深かったです． 

お昼休憩を挟んで，午後から NNC を用いた実習が行われました． NNC ではデータを入力する入力層，

処理をするための畳み込み層，次にどう伝達するかを判定する活性化関数，圧縮するためのプーリング

層，ネットワークの精度を評価するためのロス関数といったものがレイヤーとして存在し，これらのレ

イヤーを繋げていくことによってネットワークを構築できます．最初の実習では画像の向きが異なる胸

部 X 線画像に対して方向分類を実施するためのネットワークを作成しました．このネットワークはレイ

ヤーを一列に繋げていくシンプルなものだったため，一つ一つの層でどのように処理しているのかを考

えやすく深層学習を身近に感じることができました．2 つ目の実習では胸部 X 線画像から肺野領域をセ

グメンテーションするためのネットワークを作成しました．今回は一列に繋ぐシンプルなものではな

く，U-Net と呼ばれるネットワークを構築しました．U-Net は前半で画像の特徴を抽出しながら画像を

縮小していき，後半で画像を元のサイズに復元しながら前半で得られた情報を統合してセグメンテーシ

ョンするネットワークで，文字通りネットワークを構築するレイヤーを U 字になるように繋げて作成し

ました．個人的には指示された通りにレイヤーを繋げてネットワークを作成していく点はそれほど難し

くはなかったのですが，自分自身でネットワークを一から構築していくことを考えたとき，もう少し理

解を深めなければならないと感じました．実習中に遅れが生じてしまった受講者に対しては Slack での

やり取りだったり，個別のリモート環境を構築しての対応だったり，すべての受講者に対して丁寧に対

応していただいたのが印象的でした．実習の最後に講師の先生から今回使用したネットワークのパラメ

ータなどを変えて性能の変化を調べてみることをお勧めいただきましたので，後日試してみたいと思い

ました．それと私が実習を受けた中で最も耳に残った内容はネットワークを構築する際に最初に入力と

出力を考えることが重要ということでした．どういった出力を得たいのか，そのためにどのようなもの

を入力するのかを念頭に置きながらネットワークを構築することは深層学習だけでなく他のことでも大

切なことだと感じました．すべての受講者の作業終了を確認し，セミナーは 15:30 ごろ終了しました．

なお，セミナー終了後も追加資料の配布や情報提供のため，Slack が活用されました． 

今回「第 43 回医用画像処理プログラミングセミナー ～おうちで学ぶ初めてのディープラーニング

～」を受講させていただき，深層学習の基礎および NNC を用いたディープラーニングへのアプローチを

学ぶことができました．また，画像部会の先生方や受講者の皆さんのお話を聞いて自分自身の研究への

モチベーションの向上にも繋がりました．いつか深層学習に触れてみようと考えて，まだあまり行動を

起こせていない方がいらっしゃいましたら，きっと得るものがあると思いますので，ぜひ次回開催され

た折に参加されてみてください． 

最後に，お忙しい中今回のセミナーを準備し開催いただいた画像部会の先生方，サポートいただいた

学生の方々に，この場を借りて御礼申し上げます．ありがとうございました． 
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第９回 臨床画像セミナーを受講して 

東海大学医学部付属八王子病院 診療技術部放射線技術科 河端 英里 

 
７月 23 日から 24 日の 2 日間に渡り、臨床画像セミナーに参加させて頂きました。今回のセミナーの

内容は物理評価と視覚評価についてでした。 

 １日目は主に物理評価に関する講義と演習がおこ

なわれました。講義では画質評価の指標として用い

られる MTF や NPS,DQE の定義から測定方法までわか

りやすく教えていただきました。また、実際に測定

を行っている様子を動画で見ることができました。

測定する際の注意点やポイントを解説してくださる

ため、自施設で測定を行うときのイメージ作りがで

きました。演習では ImageJ と Excel を使用し実際に

DQE や NPS を算出しました。演習は各々のパソコンで

作業するのですが、分からない点は個別に対応して

もらえるため安心して演習の内容に集中することがで

きました。 

 視覚評価に関する講義では視覚評価の種類やその使い分け方、試料作成から解析までの流れを教えて

いただきました。演習では一対比較法による視覚評価と ROC Viewer を用いた観察者実験を行いまし

た。私は一対比較法の演習でうまく評価結果を出すことができないまま１日目を終えたのですが、白石

先生に時間外にも関わらず快く対応していただき、無事に結果を得ることができました。セミナー全体

を通して先生方は随時質問を受け付けてくださるため、疑問が残ることもありませんでした。 

 今回はコロナ禍のため少人数で行われた臨床画像セミナーでしたが、先生方は熱心に教えてくださ

り、とても中身の濃い２日間を過ごすことができました。知識を深めることができ嬉しく思う一方で、

自分の知識不足を痛感しました。頂いた Excel シートと ROC 解析ソフトを使って実際に物理評価や視覚

評価を行えるよう、今回教えていただいたことを復習して定着させたいと思います。 

 最後になりますが、本セミナーを企画・運営してくださった日本放射線技術学会画像部会の先生方な

らびに東京支部の皆様に心より御礼申し上げます。 

講義中の様子 

読者のページ 
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第 9 回 臨床画像評価セミナーを受講して 

東京都立大学大学院 片瀬 知樹 

 

2022 年 7 月 23 日、24 日の 2 日間にわたって開催されました臨床画像評価セミナーに参加いたしまし

た。コロナ第 7 波の影響で対面開催が危ぶまれましたが、感染対策を万全に講じた上でのセミナー開催

となりました。 

以前より X 線画像の NNPS解析プログラムを作成しており参考書とともに研究を進めていましたが、

初めてのプログラミングと画像評価に対する知識不足で行き詰まりを感じていました。どうしたものか

と右往左往していたところ、所属研究室の教授より本セミナー開催の情報を紹介され、画像評価法を講

義と演習を通して学べるという魅力的な点に惹かれ応募いたしました。以下には本セミナーを受講して

よかった点を報告いたします。 

まず本セミナーの受講動機でありました NNPS に関してとても理解が進みました。講義では基礎的な

ことからお話ししていただきましたが、知識不足の私には非常にわかりやすい内容でした。恥ずかしな

がら「粒状性」と「ノイズの割合」に関する言葉の定義というものをしっかりと理解していなかったた

め、認識を改めるという点でも非常に良かったです。演習では image J を使用して入出力特性、ノイズ

特性、解像特性、NEQ・DQEと一連の流れに沿って行われましたが、画像の取得方法や撮影方法について

も紹介いただき、参加者が自分の施設でも行えるような説明もあり大変参考になりました。 

次に視覚評価に関する講義、演習がとてもわかりやすかったです。今までの研究から物理評価に関し

ては多少の知識はありましたが、視覚評価に関しましては国家試験に合格できる程度の知識しかありま

せんでした。不安の中での参加となってしまいましたが、講義と演習を通して初学者の私でも非常に理

解しやすい内容となっていました。本セミナー開催前に多少なりとも知識をつけていけばより質問など

できたのではないかとその点は反省しております。 

最後に講師の方々にとても質問しやすい環境でありました。コロナ禍という影響で受講者に対するス

タッフの数がおよそ 1:1 で、演習で困った際もすぐに講師の方にフォローしていただけました。また、

講師の方々皆様が声をかけやすい方々でしたのでとても質問しやすく感じました。初歩的な質問を幾つ

かしてしまいましたが、丁寧にお答えいただきましたこと深く感謝しております。 

本セミナーには冒頭に書きました通り、私は物理評価方法に関して学びたいと思い参加いたしまし

た。しかし参加して物理評価は勿論のこと、視覚評価に関してもとても勉強になりました。研究に関し

て必要であるから受講するというのは勿論ですが、私のように思いがけない発見や学びがあるため興味

のある方は受講することをお勧めいたします。 

最後になりましたが、臨床画像評価セミナーを開催および運営していただきました日本放射線技術学

会画像部会及び東京支部の皆様に心よりお礼申し上げます。 

読者のページ 
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プログラミングで使える DICOM タグの活用 

つくば国際大学 医療保健学部 診療放射線学科  川田 悟 

 

１． はじめに 

現在，深層学習を用いた研究は活発に行われており，放射線領域の論文数も爆発的に増加をしている．

実際，深層学習を個人でプログラミングして実装する際，選択肢として考えられるのは「python」や

「Neural network console」などが挙げられる．「Neural network console」は自身でコーディングする

ことなく直感的に深層学習を用いた AI 開発を体験できる．その反面，無料利用枠やワークスペースなど

が決められており制限がある．そこで，始めの垣根は高いもののほとんど制限がない「python」を学ぶこ

とは今後の研究活動に大きな利点となる． 

また，医用画像を深層学習させる際，1 枚のみを処理することはまれであり，多くはボリュームデータ

を扱うことになる．深層学習させるために入力する医用画像は，基本的に前処理と言われる目的に応じて

拡大縮小・反転などのアフィン変換，二値化やしきい値などの処理を行う．「python」上でこれらの処理

を行うことも可能であるが，枚数が多い場合は時間がかかってしまう．そこで，「C 言語」と呼ばれる比

較的高速で処理を行うことのできるプログラミング言語で処理をすることが多い． 

以上の点から今回の講座ではプログラミングで使える DICOM タグの活用ということで 

1. DICOM データの構造 

2. 「C 言語」による DICOM の処理方法 

3. 「python」による DICOM の処理方法 

を中心に話すことにする．DICOM データの構造を学ぶことにより，直接 DICOM データから画像を読み

込んだり画像を読み込む際の入力情報を少なくできたりするなど多くのメリットがある． 

 

 

２．DICOM データの構造 

DICOM ファイルは DICOM タグにより情報が整理されている．DICOM タグは「グループ番号」「エレメント

番号」に分けられ，それぞれ表１のように分類される．ここで一つ誤解をされることが多いところである

が，ヘッダー情報と画像データは全く独立しているものではないことを記しておく．すなわち，画像デー

タも DICOM タグにより整理される情報の一つということが表よりわかる．画像を読み込むこととヘッダ

ー情報を読み込むことは本質的には変わらないことを示している． 

また，画像データを読み込むときに必要な Row や Columns などは画像から直接読み込むことが出来れ

ば余計な手間は減らせる．DICOM タグを制する者は画像研究を優位に進められると言える． 

専門部会講座（入門編） 
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表 1 代表的なタググループおよびエレメント番号 

タグ番号 情報種別 エレメント番号 

(0008,XXXX) 検査情報 検査日付    (0008,0020) 
モダリティ   (0008,0060) 

(0010,XXXX) 患者情報 患者氏名    (0010,0010) 
患者体重    (0010,1030) 

(0018,XXXX) 画像収集情報 検査部位    (0018,0020) 
曝射時間    (0018,1150 

(0020,XXXX) 画像付帯情報 検査 ID     (0020,0010) 
患者方向    (0018,0020) 

(0028,XXXX) 画像表示情報 行       (0028,0010) 
列       (0028,0011) 

 画素情報(画像) 画素データ   (7FE0,0010) 

 
 
３．「C 言語」による DICOM の処理方法 

C 言語はプログラミング言語の中でも歴史が深く，特徴として汎用性が高いことが挙げられる．すな

わち目的に応じて拡張が容易であると言える．今回は，C 言語を拡張した C++言語を用いる．C++言語で

は画像データを直接読み込む関数は用意されていない．ゆえに自分で DICOM データを読み書きするよう

にプログラミングしなければならない．そこで用いる関数として「fread 関数」「fseek 関数」「fgetpos

関数」などがある．「fread関数」はファイルから指定バイト数のデータを指定した数だけ読み込む関数

である．また「fseek 関数」はファイル読み込み位置の指定子を，条件を満たす位置まで移動する関数

であり，「fgetpos 関数」は読み込み位置を取得する関数である．具体的に DICOMデータを処理するには

どのようにするのか以下にプログラミングコードを記す． 

 
1 fseek(fp, 0, SEEK_END); 
2 fgetpos(fp, &pos); 
3 head = pos - (nx * ny * 2); 
4 fseek(fp, head, SEEK_SET); 
5 for (int i = 0; i < nx * ny; i++) { 
6  fread(&ims, sizeof(short), 1, fp); 
7  img[i] = (float)ims; 
8 } 
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 このコードがどのような処理をしているか説明する 

(1 行目)DICOM データの終端の位置までファイル位置の指定子を移動する 

(2 行目)指定子の位置を取得する（ファイルサイズが取得される） 

(3 行目)その位置から画像のデータ量の分だけ差分することで画像データの最初の位置を同定する  

※nx、ny は画像の幅と高さの大きさを示す． 

※DICOM の画像データは 2 バイト整数型（short 型）なので，nx * ny * 2 で画像サイズを表している． 

(4 行目)画像データの始まり位置までファイル位置の指定子を移動する. 

(5～8 行目)実際に画像を読み込む 

※ DICOM の画像データは 2 バイト整数型（short 型）なので，画像処理に適した単精度浮動小数点型

（float 型）に変換しながら 1 画素ずつデータを読み込んでいる． 

 
このように，画像を読み込むだけでもファイル位置の特定を自分で行うなど様々なことを考えなけれ

ばならない．仕様自体は単純であるが明快ではなく難解である．しかし逆を返せば，基本的なことを知

っていれば自分でいくらでもカスタマイズできるという点でメリットでもあると言える．そして「Ｃ言

語」はコンパイラ言語と言って，自身がプログラミングした処理をコンピュータが処理する機械語に変

換してから実行するため，高速な処理が可能となる．Python はインタープリタ言語と言って，1 行ずつ

コードを解釈しながら実行しているので，実行速度が遅くなる．また，Python などの言語ではバックグ

ラウンドで自動的にその他の処理が実行されることが多く，Ｃ言語に比べて処理内容を把握することが

困難な場合が多い．まとめると「Ｃ言語」は実行する処理が明確で，機械語に変換してから実行するの

で高速であると言える． 

 
 
4．「python」による DICOM の処理方法 

「python」による DICOMデータの処理方法は「pydicom」と呼ばれる DICOMファイルを扱うための

Python ライブラリを用いる． 

 
1 import pydicom 
2 path = pydicom.data.get_testdata_file(“○○.dcm”) 
3 dataset = pydicom.filereader.dcmread(path) 
 
 このコードがどのような処理をしているか説明する 

(1 行目)pydicom を使用することを宣言する． 

(2 行目)DICOM ファイルへの絶対パスを取得する． 

(3 行目) DICOM ファイルの読み込みを行う． 
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 C++では，様々なことを考慮しなければいけないが「pydicom」では読み込みはファイルへの絶対パス

があれば１行で読み込むことが出来る．このように「pydicom」は DICOM データを取り扱うことに特化

したライブラリである． 

 
「pydicom」は DICOM 規格の複雑さを吸収してくれる．ゆえに深層学習していくうえで大きな武器に

なる．また，「Ｃ言語」は高速処理ができ，自身で色々カスタマイズできるので前処理に適している．

それぞれの長所を適材適所で用いていくことが画像研究にとって重要であると考える． 
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ImageJ を用いた画像処理 

大阪大学医学部附属病院 医療技術部 荻原 良太 

 

1. はじめに 

 

 ImageJ は極めて強力な画像処理および画像解析ソフトである．直感的に分かり易いユーザーインター

フェースに加えて，世界中のユーザーが種々の拡張機能を開発し無料公開・頒布してきたことで広く利用

されている．放射線技術科学分野においても DICOM (digital imaging and communications in medicine) 

形式を含む数多くの画像形式に対応していることから幅広く活用されている．本講座では基礎的な医用

画像処理について ImageJを用いながら解説を行う． 

 

2. ImageJ 使用上の留意事項 

 

2-1. ビット深度 

 ビット深度とは 1 ピクセル当たりに割り当てるデータ量のことである．ImageJ で画像を開くと画像タ

イトルの下に画像サイズ・ビット深度・データサイズの並びで画像情報が表示される（図 1）．例えば 16 

bit の画像は 2 の 16 乗分の階調域があり，1 ピクセルは 0 から 65535 (=216-1)までの画素値を持つことが

可能である．なお 8 bit および 16 bit の画像は負の値や小数を持つことが出来ないため，画素値を小数

倍する場合や画像間で減算または除算する場合には十分に注意する必要がある（表 1）．このような処理

を行う際はビット深度を 32 bit まで広げることも考慮するべきである． 

 

 

 

 

 

 

 

 

 

 

 

 

 

ビット深度 画素値の範囲 負の値 小数 

8 bit 0 から 255 × × 

16 bit 0 から 65535 × × 

32 bit 非常に広い 〇 〇 

表 1 画素値の取り得る範囲 

図 1 画像情報の表示位置 

専門部会講座（入門編） 

53



2-2. 対象ウィンドウの選択方法 

 画像処理は 1 枚の画像または複数の画像を対象とする．前者の場合，アクティブな画像が対象となるた

め事前に画像ウィンドウをクリックして選択しておく必要がある．後者では，対象画像を選択するのに画

像タイトルを用いるので画像ウィンドウの上方部を確認しておく必要がある．画像タイトルは用途に合

わせて変更しておくことを推奨する．画像タイトル変更などの各種処理は ImageJ のメニューバーから実

行可能である．本講座で扱う処理を，本稿末尾にある表 2 に纏めるので必要に合わせて確認されたい． 

 

3. ImageJ を用いた画像処理 

 

3-1. アンシャープマスク処理 

3-1-1. 概要 

 アンシャープマスク処理は，画像の鮮鋭度を補正する鮮鋭化処理である．図 2 に画像処理の概要を示

す．始めに，原画像と原画像を平滑化した平滑化画像との差分を取ることで画像内の高周波成分を抽出す

る．この高周波成分に任意係数を乗算して成分を強調し，原画像に加算することで高周波数強調画像が作

成可能である．強調される周波数成分は平滑化の度合いによって異なる．度合を小さくすれば高周波成分

のみが，大きく平滑化すればより低周波の成分まで強調されるため，観察対象の大きさや形状に応じて適

切に変化させることが望ましい． 

3-1-2. ImageJ による処理方法 

 ImageJ はデフォルトでアンシャープマスク処理が可能である．平滑化フィルタにはガウシアンフィル

タが採用されている．デフォルト機能を使用する際はガウス関数の標準偏差σが取る距離，つまり信号値

が約 61%に減衰するフィルタの半径と，高周波成分画像に乗算する係数の値を設定する必要がある．ガウ

シアンフィルタ以外の平滑化手法（たとえば Mean フィルタなど）を適用したい場合は，複製した原画像

に対して任意の平滑化フィルタを適用することで平滑化画像を作成し，Image Calculator の機能によっ

て原画像との差分を取得する．この差分画像（高周波成分画像）に対して Mathの Multiply 機能を用いて

任意の強調係数を乗算し，この画像を原画像に加算することで高周波数強調画像の取得が可能である． 

 

図 2 アンシャープマスク処理 
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3-2. エネルギーサブトラクション処理 

3-2-1. 概要 

 エネルギーサブトラクション法は，異なる 2つのエネルギーで撮影された画像を荷重減算することで，

骨成分を消去した軟部組織画像や，軟部組織成分を消去した骨画像を作成する手法である．骨に重なる異

常陰影の識別を容易にし，骨部の視認性を向上させることで診断支援の役割を担っている．現在採用され

ているエネルギーサブトラクション法は軟部画像と骨部画像とを交互に求める繰り返しのアルゴリズム

を使用している．また，被写体厚の違いによって適切な荷重係数を設定する新しいエネルギーサブトラク

ション処理が開発されている． 

3-2-2. ImageJ による処理方法 

 ImageJ のデフォルトの機能だけでは前述の複雑なアルゴリズムによるエネルギーサブトラクション法

を実現することは極めて難しい．ただし画像の局所領域のみを対象とするなら，荷重係数を用いた画像間

の単純減算によって軟部組織と骨部組織とを分離することは可能である．本講座では右下肺野領域のみ

に注目してエネルギーサブトラクション処理の結果を検討する． 

 始めに，Math の Multiply 機能を用いて高エネルギー画像と低エネルギー画像に対して荷重係数を乗算

する．次に，この 2 画像を Image Calculator の subtract 機能によって減算する．画素値が負の値を取る

可能性があるので subtract機能を用いる際は 32 bitにビット深度を変更することを忘れてはならない．

図 3 に示すように荷重係数を適切に設定すれば，画像間の単純減算処理だけでも軟部組織と骨部組織と

の分離が可能である．画像の明るさとコントラストを調節することで 2 画像の比較が容易となる． 

 

 

3-3. マルチ周波数処理 

3-3-1. 概要 

 マルチ周波数処理は，画像の鮮鋭度を補正する鮮鋭化処理であり，アンシャープマスク処理の原理を踏

襲している．アンシャープマスク処理との相違点は複数の平滑化画像を作成することであり，これによっ

て画像内の異なる周波数成分を自由に調節できる．マルチ周波数処理では平滑化フィルタのサイズや周

波数成分に対する強調係数など，設定するべきパラメータは多く，観察対象物のコントラストや大きさな

図 3 荷重係数を用いた単純減算によるエネルギーサブトラクション処理 
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どに注目し適切にパラメータを選択することが重要となる． 

3-3-2. ImageJ による処理方法 

 処理方法の概要を図 4 に示す．アンシャープマスク処理と同様に，始めに平滑化画像を作成する必要が

ある．原画像を複数枚，複製した後に重み付け平均であるガウシアンフィルタをそれぞれに適用させる．

フィルタサイズには異なる値を設定する必要がある．Image Calculator の subtract 機能を用いて平滑化

画像と原画像との差分を取り，Math の Multiply 機能によって差分画像に任意の強調係数を乗算する処理

はアンシャープマスク処理と同様である．この時，画素値が負の値または小数を取ることがあるため

Image Calculatorを使用する際はビット深度を 32 bitに変更することを忘れてはならない．最後に Image 

Calculator を使用して，各周波数成分の画像を原画像に加算することで周波数強調画像を作成できる．

肺野内の血管や椎体骨の鮮鋭度の向上が確認できる． 

 

 

3-4. ダイナミックレンジ圧縮処理 

3-4-1. 概要 

 ダイナミックレンジ圧縮処理は，画像のコントラストを補正する処理である．モニタなど表示系のダイ

ナミックレンジが狭い場合，高濃度部には黒つぶれ，低濃度部には白飛びが発生し，関心領域の視認性が

損なわれる場合がある．ダイナミックレンジ圧縮処理とは，関心領域のコントラストや高周波成分を保持

したまま黒つぶれや白飛びを補う処理である． 

3-4-2. ImageJ による処理方法 

 ダイナミックレンジ圧縮処理は，平滑化画像内の関心領域のみに対してダイナミックレンジ圧縮処理

を行い，これを原画像に対して減算することでコントラスト補正を行うというものである．平滑化画像を

減算するため高周波成分を保持しながら濃度補正が可能となる．本講座では縦隔部の白飛び領域の濃度

補正を目的として画像処理を行う． 

処理方法の概要を図 5 に示す．始めに，原画像を複製し平滑化フィルタで平滑化画像を作成する．次に

図 4 マルチ周波数処理 
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表 2 をもとに，Threshold と Mask 機能を使用して平滑化画像から低濃度部を抽出する．図 6 に示す

Threshold ウィンドウ内の 2 本のスクロールバーを調整して，平滑化画像から抽出対象となる低濃度領域

をハイライトさせる．図 5 の赤色部分が抽出領域に相当する．この時，Threshold ウィンドウ内の Apply

ボタンをクリックしないように注意する．図 6 の通り，本例では抽出対象の画素値が 2553 から 3532 の

範囲にあることが分かる．ここで Mask 作成処理を行うと，ハイライト領域の画素値が 255，それ以外は

0 のマスク画像が作成される．さらに，Math の Divide 機能によりマスク画像全体を 255 で除算すること

で画素値が 0 と 1 のバイナリ画素に変換できる．このバイナリ画像の作成がポイントであり，Image 

Calculator の Multiply 機能を用いて平滑化画像とバイナリ画像を乗算することで，平滑化画像から関心

領域のみが抽出できる． 

ダイナミックレンジ圧縮には階調圧縮テーブルを用いる．このテーブルは入力濃度に対して単調減少

する形状を有している必要があり，これによって低濃度側の濃度を持ち上げる働きがある．ImageJ では

calibrate 機能を用いることで階調圧縮テーブルの作成が可能である（図 7，表 2）．Calibrate ウィンド

ウの左枠内には関心領域内の画素値を，右枠内には階調圧縮後の画素値を入力する．本例では関心領域内

の画素値は 2553 から 3532 の範囲内にあった．より低濃度域（画素値 3532）のコントラストを抑えるこ

とがダイナミックレンジ圧縮の目的であるため，画素値 3532 には約 25%相当の 830 を設定する（のちほ

ど画素値 3532 から 830 を減算して白飛びを抑制するため）．画素値 2553 の濃度域は保持したいので 0 と

入力する．図 7 のように階調圧縮テーブルには指数関数（Exponential）を選択し，左枠内には画素値 2553

から 3532 までの数値を，右枠内にはその数値に対応した指数関数が取り得る値を適切に入力する．以上

の処理を実行することで，関心領域内の画素値が階調圧縮される（2553 から 3532 まで線形的に分布して

いた画素値が，0 から 830 までの指数的な階調に変化される）．最後に，原画像から階調圧縮後の画像を

減算する．白飛びしていた領域のコントラストが抑制され縦隔部の視認性の向上が確認できる． 

 

図 5 ダイナミックレンジ圧縮処理 
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項番 処理内容 ImageJ メニューバーからの実行方法 

2-1 画像を開く File > Open... 

2-1 ビット深度の変更（32 bit） Image > Type > 32-bit 

2-2 画像タイトルの変更 Image > Rename... 

3-1 アンシャープマスク処理 Process > Filters > Unsharp Mask... 

3-1 画像の複製 Image > Duplicate... 

3-1 Mean フィルタの適用 Process > Filters > Mean... 

3-1 2 画像間の減算 

Process > Image Calculator... > Subtract 

※ Image1 は原画像，Image2 は周波数画像のタイトルを選択 

※ Create new window に☑を入れる 

※ 32-bit (float) result に☑を入れる 

3-1 画像全体を乗算 Process > Math > Multiply... 

3-1 2 画像間の加算 Process > Image Calculator... > Add 

3-2 明るさ/コントラストの調節 Image > Adjust > Brightness/Contrast... 

3-3 ガウシアンフィルタの適用 Process > Filters > Gaussian Blur... 

3-4 Threshold 画面の呼び出し Image > Adjust > Threshold... 

3-4 マスク画像の作成 Edit > Selection > Create Mask 

3-4 画像全体を除算 Process > Math > Divide... 

3-4 Calibrate 画面の呼び出し Analyze > Calibrate... 

図 6 閾値の設定 

図 7 calibrate 機能 

表 2 取り扱う処理の実行方法 
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4. おわりに 

 本講座では医用画像で用いられている画像処理について，ImageJ の機能と併せながら解説を行った．

画像処理のみならず，ImageJ は画素値の測定や特徴量抽出などの画像解析においても優れた機能を有し

ている．他に何が出来るのかなと，興味を持ち一つ一つの機能を試してみて頂きたいと願う． 

 ImageJ には，プログラミングで作成できるマクロとプラグインという拡張機能がある．プログラミン

グの知識があればマクロの作成は比較的容易であり，本講座で取り扱った大部分はマクロによって自動

化・簡略化することが可能である．限定された機能のマクロと比較してプラグインは拡張性が高く，種々

のプラグインを世界中のユーザーが開発しインターネット上で公開している．複雑な画像処理や画像解

析などは，マクロで自作するのも一つの手だが，インターネット上で探してみるのが研究の近道になるか

もしれない．近年，人工知能の分野において脚光を浴びているプログラミング言語 python の構文でもプ

ラグインの作成が可能であるので，ImageJ の深淵を覗きたい人は是非プラグイン開発に挑戦して頂きた

い．本講座の内容が読者の皆様の研究や業務に役立つのなら幸甚に存じる． 
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九州大学 医学部保健学科 放射線技術科学専攻 

井手口研究室の紹介 

九州大学大学院 医学研究院 保健学部門 井手口 忠光 

１．九州大学について 

 改めまして、九州大学を少しだけ紹介させていただきます。九州帝国大学の初代総長として明治 44 年

に赴任された山川健次郎先生は、皆様にも関係が深い先生でもありますが、ご存じでしょうか。NHK で放

送された「八重の桜」で有名な白虎隊として明治政府との戦を経験され、その後渡米。明治 34 年、48 歳

の若さで東京帝国大学の総長に就任されています。そして特筆すべきは、東京帝国大学・物理学の教授時

代に日本最初の X 線発生実験に成功された先生でもあります(明治 29 年：1896)。 

 そのような歴史背景をもった九州大学に医学部付属のエックス線技師学校が設置されたのが昭和 29年

(1954)、その後、医療短期大学部が昭和 46 年(1971)と記録されています。2002 年には医学部保健学科に

改組され、今年で 20 回目の入学生を迎えています。さらに 2007 年に修士、2009 年には博士課程が設置

され、今に至っています(詳細は画像通信 Vol.31 No.1：東田先生)。 

医学部保健学科のキャンパスは福岡市

東区馬出（まいだし）にありますが、敷

地の中心には 2009 年完全竣工した九州

大学病院が建ち、医学部(医学科、保健学

科)、歯学部、薬学部が設置されています。

馬出キャンパスは九州帝国大学発祥の

地であり 120年の歴史を誇る場所でもあ

ります。敷地内の 80 年～90 年経過した

建物は新病院建築の同時期にリノベー 

写真 1 保健学科本館（2 年～3 年生の学び舎）    ションされ、長い歴史と伝統を受け継いだ

新キャンパスに生まれ変わっています（写真 1）。 

 

２．井手口研究室 

そのような歴史の九州大学 馬出キャンパスに 2019 年 9 月 1 日付で赴任いたしましたが、卒後 40 年ぶ

りの学び舎は、感慨深いものがあります。後期が始まる 1 か月前という、中途半端な時期での赴任でした

が、新しく担当する科目の資料準備や次年度からの研究室のハードおよびソフト面の整備も含めて、あっ

という間に半年が過ぎ去ってしまいました。九州大学では学部 3 年生の 2 月頃に配属先の研究室が発表
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されますが、それまでは主に保健学科本館で学びます。学部 4 年生になると隣接している基礎研究 B 棟

の各研究室で１年間過ごすことになります（写真 2）。私も 2020 年度 4 月から、学部卒研生を 4 名担当す

ることとなり張切っていましたが、忘

れもしないあのコロナ禍となり井手口

研究室（通称：いで研）は、波乱の幕開

けとなりました。振返ると COVID19 は

いろいろな所に負の遺産を刻みました

が、Zoom 等の新しい社会形態も生み出

し、万事塞翁が馬とはこういったこと

か、と思ったりもします。                  

写真 2 基礎 B 棟 (教員, 学部 4 年生,修士/博士の研究室) 

 

ところで、九州大学の 4 年生は 5 月の連休明けから 11 月上旬まで臨地実習を行っていますが（途中夏

季休暇）、週のうち水・木・金曜日の 3 日間が病院実習、そして月・火曜日が研究日として時間割が組ま

れています。その合間に国試模試や就活など 4 年生は非常に忙しい日々を過ごしていますが、それらをし

っかりとこなしていく九大生の底力を感じます。 

そして、ようやく 2022 年度から「いで研」は修士 3 名（うち社会人 2 名）学部卒研生 4 名、総勢７名

にて研究室として形が整い研究活動を行っています（写真 3-4）。いで研では、修士は週 1 回、学部は隔

週１回のペースで研究室ミーティングを開催し、研究の進捗を報告することにしています。修士のミーテ

ィングは社会人が 2 名いるために 18：30 または 19：00 から開始していますので、報告内容によっては帰

宅が 21 時を過ぎることもよくあります。また、修士の学生にはそれぞれ担当の学部生がおり、国家試験、

就活含めて先輩として相談に乗り、さらには研究の指導者として自らも学びながら成長しています。 

いで研では、学部生は地方大会（九州放射線医療技術学術大会）での発表を、大学院生は国際大会(JRC

含む)での発表を目標に各自の研究テーマに取組んでいます。現在行っている主な研究は、Eye-trucking 

による注視点解析の研究、構造類似度 SSIM や複素ウェーブレット CW-SSIM による新しい医用画像（DR,CT）

評価の研究、さらには GAN を用いた Deep-learning 等々です。その他にも、自然言語処理の研究など今ま

で取組んで来なかった新しい分野の研究にも挑戦しています。まだ、それらを計算できる GPU搭載の Deep-

learning PC は研究室に１台しかないのですが、研究費を確保して順次増やしていきたいと思っていま

す。その他にも、前大学でも同僚だった田中研究室とは専門分野も同じことから、共同で進めている研究

もいくつかあります。その中で特に 2020 年度から開始した富士フィルムとの共同研究「DR の線量指標と

基本的な画像特性」では、九州大学病院と九州中央病院そして済生会福岡総合病院も交えて研究をすすめ

ています。しかし、ここでも COVID19 の影響で病院への立ち入りが制限されたり、入院患者さんの状況で
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研究への対応が難しかったり等、当初の計画よりかなり遅れてしまいました。 

写真 3 研究室のメンバー(修士の入学式）      写真 4  研究室にて(就活と勤務で 2 名不在) 

 

しかしその様な状況の中、少しずつその成果もまとまり 2021JSRT 秋季、そして 2022JRC でも発表を行い、

現在ヨーロッパの学会にエントリー中です。この研究には学部生数名も参加しており、地方学会でその成

果の一部を発表しています。 

この様にようやく軌道に乗ってきた「いで研」ですが、残念なことにまだ１度も学生たちと親睦会（飲

み会）を開催できていません。そう、緊急事態宣言です。振返るとお店を予約しては延期、予約しては延

期を、何度繰り返したことか。さらに、4 年生は臨地実習の最中であるため、病院職員の方々と同様の慎

重な行動制限を行っています。この原稿に掲載する「集合写真」は親睦会で撮る予定だったのですが、残

念ながら今回も延期となり叶いませんでした。今話題の「青春は密」ではないですが、学生達のためにも

一日も早い収束と日常が戻ってくることを願っています。 

 

３．最後に 

 九州大学では他大学からの大学院受験を大いに歓迎しています。もし、この原稿を読んでいただいてい

る先生方の研究室で興味を示す学生さんがいましたら、是非とも以下 URL をクリックしていただいて、興

味ある研究室に紹介いただければ幸いです。 

Advanced Medical Quantum Technological Science Course Division of Medical Quantum Science (kyushu-

u.ac.jp) 

4 年目に突入した研究室ですが、私も還暦過ぎて早１年、無理がきかない年齢になってきました。しか

し、何か一つでも小さな足跡を、伝統ある九州大学に残せるよう奮闘しています。今後とも、どうぞよろ

しくお願いいたします。 
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CARS2022 参加報告 

愛知県立大学 情報科学部 情報科学科 川本 真大 

 
2022 年 6 月 7 日（火）から 10 日（金）までの 4 日間，Computer Assisted Radiology and Surgery 

(CARS)2022 が開催されました．本学会に参加し，ポスター発表を行ないましたので報告いたします． 

CARS2022 では，36th International Congress and Exhibition on Computer Assisted 

Radiology(CAR)，24th International Conference on Computer-Aided Diagnosis and Artificial 

Intelligence(CAD-AI)，26th Annual Conference of the International Society for Computer Aided 

Surgery(ISCAS)および 13th International Conference on Information Processing in Computer-

Assisted Interventions(IPCAI)の 4 つの会議が開かれ，24 か国から 277 題の研究発表が行われまし

た．開催地は，東京都の虎ノ門ヒルズで，東京における開催は，1998 年から 24年ぶりの 2 回目です． 

私は，CAR の初日のセッションにおいて，「Skeletal muscle segmentation by simultaneous 

learning of particular superficial back muscles using 2D U-Net in torso CT images」という題

目で，ポスター発表を行いました．ここでは，背面に隣接する骨格筋の同時学習に着目し，僧帽筋のセ

グメンテーションでは，脊柱起立筋を用いた同時学習によってその認識精度が向上するという発表を行

いました．発表方法は，事前に英語で収録した映像がメインホール（図 1）で映され，ポスターを設置

した別のホール（図 2）で質問を待つという形式でした．映像は大画面のホールにおける見やすさや聞

き取りやすさを想定し，何回も収録しました．会場では，見渡せば海外の参加者が多数であり，同世代

の発表者とも交流ができ，対面開催の良さを実感できました．  

国際学会への参加は初めてでしたが，ハイブリッド開催で海外からのスライド聴講者のための動画作

成や対面参加のポスタープレゼンやディスカッションなど，準備から発表まで 1 回の参加で多くの貴重

な経験ができました．また，海外からの参加者も想像以上に多く，コロナ禍の国内開催の学会ではあり

ましたが，国際会議の雰囲気を実感できました．とはいえ，ランチョンの時間などでは黙食など，まだ

まだ緊張感のあるものでした．CARS2023 はドイツのミュンヘンで開催されるため，研究とともに英語力

もさらに鍛え，国外の国際会議における初の発表と交流に向け準備してきたいと思います．  

  
図 1．メインホールの様子 図 2．ポスター展示の様子 

 

国際会議案内・報告 
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読者のページ  （コーナー名は編集部で追記するので不要） 

画像部会「研究情報サイト」のご案内 

岐阜大学教育学部技術教育講座 福岡 大輔

１．はじめに 

画像部会の部会ホームページでは，これまでに本誌

「画像通信」において紹介されたトピックスや，各種

医用画像データベースに関する情報，プログラミング

に関する情報などを集約し情報提供を行う「研究情報

サイト（http://imgcom.jsrt.or.jp/research/）」を

2017 年 11 月に開設いたしました（図 1）． 

研究情報サイトは，画像研究に携わる研究者や，研

究を始めてみようと考える初学者の，情報提供や情報

交換の場となることをめざしています． 

2. 研究情報サイトの概要

研究情報サイトでは，図 2 のように画像研究に役立

つ情報として，本稿の執筆時点では，以下の 3 つのテ

ーマについて情報提供を行っています． 

(1) 医用画像データベースに関する情報

近年話題の深層学習をはじめとする画像研究におい

ては，多くの画像から共通する特徴を抽出することに

よって成り立っており，画像データベースの必要性が

高まっている．しかしながら，CAD(Computer-aided 

Diagnosis)システムの開発や性能評価の研究において

は，研究に用いる医用画像データの収集や，付随する所

見データの入手は，倫理上や個人情報の観点からも近

年では難しくなっている．そこで，研究情報サイトで

は，国内外の大学や政府機関，各種学会など公的な機関

が公開するデータベースを紹介している． 

例えば，胸部 X 線画像においては，日本放射線技術

学会標準ディジタル画像データベースをはじめ，NIH 

図 1 画像部会 HP の「研究情報サイト」 

図 2「研究情報サイト」の掲載情報 

画像部会 HP「研究情報サイト」の紹介

64



Clinical Center の Ronald M. Summers 氏らの ChestX-ray8 データベースなどを紹介している．ChestX-

ray8 データベースにおいては，症例数が患者数 30,000 で画像数も 100,000 画像と非常に豊富であるた

め，深層学習を用いた画像研究に有用なデータベースとなっている．また，画像通信 40(1)「Radiomics

に関係した文献とデータベース等の紹介」において紹介された Radiomics研究用のデータベースとして，

The Cancer Imaging Archive(TCIA)の医用画像と遺伝子の情報セット(The Cancer Genome Atlas (TCGA))

を研究情報サイト上で紹介している． 

(2) プログラミングに関する情報

画像処理プログラミングに関する情報として，画像通信 35(2)に紹介された GUI（Graphical User

Interface）による画像処理ソフトウェア開発の基本となる「C#プログラミングによる画像表示ソフトの

作成（超初心者編）」のソースコード一式や，画像通信 35(2)において紹介されている OpenCV（Open source 

Computer Vision library), 画像通信 32(1)「CAD のための統計解析の資料」に紹介されている統計解析

ソフト R（The R Project for Statistical Computing）を掲載している．また，医用画像を取り扱う上

で必要となる DICOM フォーマットに関する情報として，ソフトウェア開発に有益な DCMTK(Dicom 

ToolKit)に関する情報と，日本画像医療システム工業会（JIRA）が公開している DICOM 規格書（日本語

版）へのリンクを紹介している． 

(3) 論文作成（文献検索など）に関する情報

 画像通信 31(2)「論文作成に役立つサイトやソフト,書籍の紹介」において紹介された米国立医学図書

館内の NCBJ がインターネット上で提供している生命科学分野の文献検索システム PubMed や，Google 

Scholar について掲載している． 

3. 今後の活用と情報提供のお願い

「研究情報サイト」は，本誌「画像通信」の誌面に掲載される記事を，インターネット上のディジタル

コンテンツとして補足する機能を担い，誌面上では提供できないソフトウェアの配布や，ソースコードな

どの提供など，画像研究に役立つ情報を幅広く配信してゆきたいと考えています．また，医用画像データ

ベースに関する情報など，医用画像に関する研究者の情報共有・提供の場として今後活用してゆきたいと

考えています． 

現在，サイト上に掲載されている掲載内容のほかにも有益な情報がありましたら，「研究情報サイト」

のページ下部にあるコメント欄に情報をお寄せください． 
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画像部会入会のご案内

医療には，X 線画像，CT，MRI，US，核医学画像，そして放射線治療用画像など，様々な画像が利用され

ています．画像部会は，これら全ての画像を対象とし，そのイメージング技術，画像評価，画像処理・解

析，コンピュータ支援診断（CAD）に関する新しい知識や技術の習得を目的とした活動を行っています．

よって，診断，治療，核医学などの専門領域を問わず，多くの学会員の皆さまに入会し，参加して頂くこ

とができます． 

春と秋に開催される学術大会においては，話題性が高く学術的価値の高い教育講演とシンポジウムを

開催しています．このシンポジウムでは，企画されたテーマの第一線の研究者らに問題提起や話題提供を

して頂いた上で，会員の皆さんを交えた討論を行い，新しい知識や技術の有用性や問題点を共有していま

す．その他，地方部会の協力を得ながら，医用画像処理プログラミングセミナー，DR セミナー，ROC セミ

ナーおよび臨床画像評価セミナーを開催して，必要な基本知識と技術の普及を図っています．こういった

活動を通して，会員の皆さんが画像研究の新しい風を肌で感じたり，学術レベルの向上や技術の臨床への

還元をして頂けるようになります．また，活動案内や情報は，学術大会前にお届けしている画像部会雑誌

「画像通信」（学術雑誌 ISSN コード付）に掲載しています．学術雑誌である「画像通信」には，教育講演

やシンポジウムの内容，注目されている技術の紹介，専門家による文献紹介，日本各地の研究室や研究会

の紹介，国際会議出席者の体験記など，参考になる記事が多数掲載されており，画像に興味を持つ会員に

とって非常に魅力的な専門雑誌となっています．  

画像部会は医療で広く利用されている画像に関する理解を深め，医療の進歩に寄与したいと考えてい

る方に入会して頂き、共に学んでいきたいと思っています．また，すでに会員の方も，是非画像にこだわ

りを持つ周辺の方々に声をかけて入会を促して頂けるようお願いします． 

［入会資格］日本放射線技術学会の会員 であること．

［入会方法］Web 上（https://www.jsrt.or.jp/data/procedure/bunka-01/）から，お申し込み下さい． 

［年会費と会員特典について］ 

1．専門部会の会員登録システムと年会費の変更について

2022 年より専門部会の入会については，正会員・シニア会員は 1 つ目の年会費は無料ですが，2 つ

目以降は各 1,000 円が別途必要です．学生会員は会費免除で全ての部会に自動的に登録されます．

2．専門部会誌の電子化について 

現在，専門部会員の皆様に冊子体で届けている専門部会誌を，2015 年 3 月発刊分より全面的に電子

化します．電子化により印刷製本費や郵送費が軽減できますので，専門部会活動の充実に充てたいと

考えています．なお，電子版の閲覧方法については，追ってお知らせします．  
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編集後記 

私が勤務校で担当している講義科目のひとつに「放射線画像工学」があり、この講義で

は放射線による画像形成論からアナログフイルムの諸特性を取り扱っています。他の大学

ではこれらの内容は縮小傾向かと思いますが、私の変なこだわり（銀塩写真は診療放射線

技師の根っこにあるものだ！←私は技師ではありませんが・・・）で頑固に長い時間を取

って講義しています。この科目に連動した実験も同様に、自動現像機を使ったフイルムの

現像や平行光濃度による特性評価を行ってきました。しかし実験室を別の棟に移動させる

ことになり、これまで修理しながら何とか動かしてきた自動現像機や平行光濃度計をつい

に廃棄することになりました。フイルム全盛だったころの装置がほとんど姿を消し、コン

ピュータや液晶モニタに囲まれた実験室はなんとなく寂しい気持ちです。 

 とはいえ技術はどんどん移り変わっています。デジタル画像が主流となり、AI技術も急

速に医療現場に導入されつつあることから、それらに関する専門的な知識も求められるよ

うになります。画像部会ではモダリティを限定せず、画像形成の基礎的な内容から最新の

AI技術まで幅広く取り扱っています。診療放射線技師の会員だけでなく他分野で活動して

いる研究者の皆様も是非画像部会にご参加いただき、画像部会を盛り上げていただけると

嬉しいです。 

Withコロナ、After コロナ時代となり、対面・オンライン・オンデマンドを組み合わせた

イベントを企画してまいります。多くの方と色々な形で交流できることを楽しみにしてい

ます。 

(AT 記) 
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